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Preface
This report contains a user’s manual for the CASE2 model version 2.2 running in a FSE Windows
environment. CASE2 is a physiological model for cacao growth and yield. It is one of the results of a
cocoa research and modelling programme of Wageningen University on behalf of the Dutch Cocoa
Association (NCV)1. The current version of the model has been developed in the period April 2001January 2002.
The user’s manual contains instructions on the installation and use of the CASE2 model and the
FSE Windows programme (FSEWin). Using the information in this report, one should be able to run
the CASE2 model with weather data from different locations and different soil types. Weather
information of 37 locations in 10 countries are included in the program files; soil information on three
soil types is also included. The report also contains information on how to add new soil types or new
weather information.
Basic background information on the procedures, model assumptions and limitations of CASE2 are
included in another report (Zuidema & Leffelaar, 2002). An extensive description of the model code
of CASE2 can be found in the technical program manual (Zuidema et al. 2002). These reports and
extra copies of this report and the CASE2 and FSEWin programs can be obtained from the Plant
Production Systems group at Wageningen University (see author’s addresses on previous page).
Any queries or comments can also be sent to the authors.
Several people have contributed in the development of the CASE2 model. Wouter Gerritsma and
Liesje Mommer developed previous versions of the model. Jan Goudriaan provided valuable input
for model development. Wouter Gerritsma gave important reference to literature and commented on
model development. Rudy Rabbinge provided overall guidance during this phase of the project.
Daniel van Kraalingen developed the FSEWin program. Gon van Laar assisted in the FSEWin
development and tested the program. Sander de Vries tested the CASE2 model. Weather data
were kindly made available by various persons at the Department of Plant Sciences and Plant
Research International (both at Wageningen University and Research Centre). Financial support
was obtained from the Dutch Cocoa Association (NCV), the Dutch Ministry of Economic Affairs, and
the Plant Production Systems group at Wageningen University. All contributions are gratefully
acknowledged.
Wageningen, January 2002

Important notice:
The CASE2 model and the FSE Windows shell will only work when Visual Fortran is installed
on the computer. See Section 2.2 for further information on purchasing and installing Visual
Fortran.

1 “Collective research for an agro-technical growth and quality model of cocoa”

Table of Contents
Preface

5

Table of Contents

7

1. Introduction

9

1.1
1.2
1.3

What is Visual Fortran?
What is FSE Windows?
What is CASE2?
1.3.1
Purposes
1.3.2
A short description
1.3.3
The model cacao tree

2. Installing the programs
2.1
2.2
2.3
2.4

System requirements
Installing Visual Fortran
Installing FST Windows
Copying the FSEWin and CASE2 files

3. General modelling procedure
3.1
3.2

Procedure for normal runs
Procedure for runs with new soil or weather data

4. Starting CASE2
4.1
4.2
4.3

Starting FSEWin
Open the CASE2 model
The FSEWin main screen
4.3.1
Menu’s and icons
4.3.2
Left pane
4.3.3
Right pane

5. Configuring the CASE2 model
5.1
5.2
5.3
5.4
5.5

5.6

Specifying a location
Specifying a soil type
Specifying production level
Specifying output frequency
Specifying the cropping system and pod characteristics
5.5.1
Cropping system
5.5.2
Cacao tree input
5.5.3
Pod characteristics and processing
Specifying reruns
5.6.1
Using the example reruns
5.6.2
Specifying new reruns

6. Adding new soil or weather data

9
9
9
9
9
10
13
13
13
13
14
15
15
15
17
17
17
19
19
20
21
23
23
26
27
27
28
28
29
30
32
32
33
35

6.1
6.2

Adding a new soil type
Adding weather data for a new location
6.2.1
Daily weather
6.2.2
Monthly weather
6.2.3
Long-term weather

7. Running the CASE2 model
7.1
7.2

Running the model
Reruns

8. Model output in tables
8.1
8.2

Model output in table format
Exporting tables to Excel

9. Model output in charts
9.1
9.2
9.3
9.4
9.5
9.6
9.7

Opening the chart screen
Selecting parameters for a chart
Selecting reruns for a chart
Zooming-in a chart
Copying a chart as a picture
Closing the chart screen
Contents of the chart screen
9.7.1
Menu’s and icons
9.7.2
The left pane
9.7.3
The right pane

10.Closing CASE2 and FSEWin
10.1 Closing CASE2
10.2 Exiting FSEWin
11.Trouble shooting and support
11.1 Warnings and errors in the DOS screen
11.2 Some possible problems in FSEWin

35
36
37
39
41
45
45
46
47
47
47
49
49
50
53
54
55
55
55
55
56
56
57
57
57
59
59
59

Literature used

63

Appendix I: List of input and output parameters

I-1

Appendix II: Error and warning messages

II-1

Appendix III: Complete listing of input files

III-1

Chapter 1: Introduction

1.

9

Introduction

1.1 What is Visual Fortran?
Visual Fortran is a program that may be used to build, edit, compile, run and debug programs
written in the Fortran language. Visual Fortran works with so called projects that contain all Fortran
source codes, data files, libraries and other files necessary for a larger program, for instance the
CASE2 model. FSE for Windows makes use of Visual Fortran for defining projects, compiling
programs and running the model.

1.2 What is FSE Windows?
FSE Windows (Fortran Simulation Environment for Windows) is a user-friendly shell to be used for
simulation models written in Fortran. It can be used to edit, compile and run Fortran programs, and
it produces output in charts and spreadsheets. The program has been developed by D.W.G. van
Kraalingen, Wageningen Software Labs (W!SL), Alterra, the Netherlands. Version 1.04 of FSE
Windows is provided with this report. The Fortran programs that run under FSE Windows make use
of the Fortran Simulation Environment (FSE, van Kraalingen 1995), a system that controls
simulation runs, takes care of reading weather and plant data and generates output files. Apart from
running Fortran models, FSE Windows may also be used to build and adapt models. For the use of
the cacao simulation model CASE2 as described in this manual, FSEWin is only used to configure
and run a simulation model and view its output.

1.3 What is CASE2?
1.3.1 Purposes
CASE2 is the Cacao Simulation Engine for water-limited production. CASE2 is a physiological
model that simulates cocoa growth and yield for different weather and soil conditions and cropping
systems. The model serves the following purposes:
(1) To estimate cocoa yields in relation to weather and soil conditions and cropping systems;
(2) to obtain insight in factors determining production;
(3) to integrate existing knowledge on the physiology and morphology of cacao trees; and
(4) to identify gaps in knowledge in the physiological basis for estimating cocoa growth and yield.

1.3.2 A short description
Below, a short description of the model is provided. More background information on the
procedures, structure and assumptions of the CASE2 model are included in another report
(Zuidema & Leffelaar, 2002). An extensive description of the model code of CASE2 can be found in
the technical program manual (Zuidema et al. 2002).
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In a simplified form, model inputs and outputs are shown in Figure 1.1. A description of each group
of inputs and outputs is provided below.

Inputs

CASE2

Weather data
Location data
Soil data
Cropping system data
Plant characteristics
(physiology and morphology)

Outputs
Bean yield
Biomass plant parts
Leaf area
Water loss
Butter hardness

Figure 1.1.
Simplified diagram of
inputs and outputs in
CASE2. Further
explanation is
provided in the main
text.

Input parameters
Weather data include precipitation, radiation, minimum and maximum temperature, and vapour
pressure. Soil data include information on the amount, thickness and physical characteristics of soil
layers. Cropping system data include information on planting density, age at the start of the
simulation and characteristics of shade trees. Plant characteristics include parameters that are used
to calculate rates of photosynthesis, respiration and transpiration; parameters that are used to
distribute biomass over plant parts (over leaves, wood, roots and pods); vertical distribution of roots
in the soil; ripening and growth of pods; leaf age, etc.
Part of the input parameters for CASE2 are time specific. Weather information (temperatures, rain,
radiation and vapour pressure) is specific for one day or for one month. In the latter case, daily
values are generated by the model on the basis of the number of rain days. Input parameters on
plant physiology and morphology, on soil characteristics and on cropping system are constant over
time.
Output parameters
Bean yield is expressed in terms of dry fermented beans. Biomass of plant parts (leaves, wood,
taproot, lateral roots and pods) as well as the growth in biomass of plant parts is obtained. Also, leaf
area and leaf area index (LAI) of the cacao trees is calculated. Information on water loss through
evaporation (from the soil) and transpiration (from the plant) is also obtained. Finally, the butter
hardness of the harvested beans and the amount of nutrients lost due to bean harvest are
calculated.
Model output can be generated for each simulation day, but also for periods of 10 days or for entire
years. In the latter two cases, summed values for parameters such as growth and yield are provided
in the output.

1.3.3 The model cacao tree
For the purpose of the simulations, the cacao tree is divided into “functional parts”: leaves, wood,
taproot, lateral root and pods (fruits). This division is shown in Figure 2.2 Also included in this figure
is the layer of leaves of the shade tree and the soil layers. Below, the characteristics of the different
parts of the cacao tree and the shade tree are explained.

Chapter 1: Introduction
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Canopy of
shade tree

Leaves

Wood

Pods

Lateral roots

Cacao tree

Figure 1.2. Schematic
representation of the model
cacao tree. The boxes
indicate the different plant
parts that are distinguished
in the model. As the model
assumes a homogeneous
and closed canopy of cacao
trees, the neighbouring
model trees border directly
to the canopy of the pictured
tree. See main text for
further explanation.

Soil layer 1

Lateral roots

Soil layer 2
Soil layer 3

Lateral roots

Taproot

Shade tree
In CASE2, shade trees are characterised by their canopy only. The shade canopy is characterised
by three parameters: the number of leaf layers (LAI – leaf area index), the extinction coefficient of
the shade tree (this is the proportion of light intercepted by one layer of leaves) and the lower and
upper height of the canopy. The first parameter may depend on the planting density of shade trees
and is specific to the type of shade tree used. The second parameter is a characteristic of the shade
species. The canopy heights are important to simulate growth and yield for cropping systems in
which short shade trees are used, causing the canopies of cacao and shade trees to overlap.
Cacao tree
- Leaves. The leaf part in the model is characterised by total leaf weight and leaf area. Leaves have
a certain leaf life span and die after having completed this life span. Additional leaf loss occurs in
situations of water shortage. New leaves are formed continuously. The leaf area index (LAI – the
number of leaf layers of the cacao tree per unit of soil surface) is another characteristic of the
canopy.
- Wood. The wood part of the tree is characterised by total wood weight, which includes both the
stem and branches of the tree. New wood is formed continuously and wood is lost as litter (fallen
branches).
- Pods. The pods (fruits) of the model tree are characterised by their weight and development stage
(ripening stage). All pods in the model are divided into age categories: pods of 1, 2, 3, etc days are
treated separately in the model. Apart from their age, pods in a category are characterised by a
certain weight and a certain development stage. When the development stage of a certain category
reaches the mature stage, pods in that category are added to the harvest.
- Taproot. The taproot of the model tree has a certain weight and a certain length. The length of the
taproot is determined on the basis of its weight (assuming that the taproot has the shape of a cone,
with a certain relation of length and diameter, and a certain wood density).
- Lateral roots. The lateral roots are divided into two parts: roots that may take up water (with a
diameter of <2 mm) and coarse roots. Both water-absorbing and coarse roots are characterised by
their weight, and both are continuously renewed; that is: part of the roots dies off each day and this
part is replaced by new roots. Water-absorbing roots are distributed over the different soil layers
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following an exponential decline of root density with increasing depth (in Figure 2.2 this is shown for
all lateral roots). These roots are distributed up to the depth reached by the tip of the taproot.
Length and surface area of the water-absorbing roots are derived from their weight, specific length
and diameter.

Chapter 2: Installation
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Installing the programs

Steps:
1.
2.
3.
4.

Check system requirements
Install Visual Fortran
Install FSE Windows
Copy CASE2 files

! Section 2.1
! Section 2.2
! Section 2.3
! Section 2.4

2.1 System requirements
Most modern IBM-compatible computers equipped with at least Windows 95 operating system will
be able to run CASE2 under FSE Windows. The following system configuration is required:
- A 90MHz (or faster) Intel Pentium (or compatible) processor
- Windows 95 (or higher)
- At least 24 MB of memory
- At least 300 MB free hard disk space (ca. 280 MB for Visual Fortran; 10 MB for FSE Windows
and 10 MB for CASE2)
- A CD-ROM drive
- A mouse installed
- A VGA monitor (17” recommended)

2.2 Installing Visual Fortran
To purchase Visual Fortran, visit the Compaq Visual Fortran web pages at
www.compaq.com/fortran. The current version of Visual Fortran is 6.6, but older versions may also
be used to run FSE Windows and CASE2. Versions of Visual Fortran named “DIGITAL Visual
Fortran” may also be used. DIGITAL Visual Fortran 6.0 was used successfully with FSE Windows
and CASE2. Note that new versions of Visual Fortran can only be obtained from Compaq.
During the installation of Visual Fortran, choose the Standard or Typical configuration (generally the
default option), without Array Visualisation (this feature is not used). It is very important that the
autoexec.bat file is updated: this is usually asked at the end of the program installation.

2.3 Installing FST Windows
The FSEWin shell that is used for the CASE2 model makes use of a companion program called
FSTWin (Fortran Simulation Translator for Windows). This program is present on the CD-ROM
included in this report and should first be installed (in case there is no CD-ROM included, contact
the authors for a free copy, see address at page 2 of this manual). In case FSTWin has already
been installed on the computer, proceed with the copying of the FSEWin and CASE2 files as
described in Section 2.4.
To install the FSTWin program:
" Place the CD-ROM in the CD-ROM player
" Choose “Run” from the Windows Start Menu
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" Type: “<drive>:setup.exe” in which <drive> is the letter assigned to the CD-ROM player.
For example: “D:setup.exe” in case the CD-ROM drive has letter D.
" Click on OK
The installation program is started:
" Follow the instructions on the screens: enter name and company name when requested and
select the default destination directory and program folder. It is important that you do
not change the destination directory (C:\Program Files\FSTWin).
The installation program copies program files and adjusts settings.
" Click on Finish when the installation is complete.

2.4 Copying the FSEWin and CASE2 files
The FSEWin and CASE2 files are present on the CD-ROM that is included in this report (in case
there is no CD-ROM included, contact the authors for a free copy, see address at page 2 of this
manual). The files are packed in a self-extractable ZIP-file and will be automatically copied to the
directories C:\Program Files\FSTWin (the FSEWin files; note the directory name \FSTWin and not
\FSEWin) and C:\Case2 (the CASE2 files).
To copy the FSEWin and CASE2 files:
" Place the CD-ROM in the CD-ROM player
" Choose “Run” from the Windows Start Menu
" Type: “<drive>:copycase.exe” in which <drive> is the letter assigned to the CD-ROM
player. For example: “D:copycase.exe” in case the CD-ROM drive has letter D.
" Click on OK
A WinZip self-extractor window is opened.
" Click on “Unzip” to start the extraction of the files. It is important that you do not
change the destination directory (C:) mentioned.
The self-extractor program copies the FSEWin and CASE2 files to different directories.
" Click on Finish when the installation is complete.
To facilitate starting FSEWin, make a shortcut of the FSEWin.exe file. To do so:
" Open the Windows Explorer
" Go to the directory C:\Program Files\FSTWin
" Select FSEWin.exe
" Right-click on the FSEWin.exe file to open the menu
" Select “Send to” and then “Desktop (shortcut)”
A new icon is placed on the desktop (Windows opening screen)

Chapter 3: Modelling procedure

3.

15

General modelling procedure

Choice:
The modelling procedure depends on the following choice:
a. Normal runs. Do simulations for different locations, soil types and cropping systems but without
adding new soil types or new weather information
! Section 3.1
b. Add soil types or weather data.
! Section 3.2

3.1 Procedure for normal runs
Steps:
1.
2.
3.
4.
5.

Start FSEWin
Open the CASE2 model
Configure the CASE2 model
Run the CASE2 model
Obtain model output in:
− table format
− chart format
6. Export model output (optional)
− table format
− chart format
7. Close the CASE2 model and end FSEWin

! Section 4.1
! Section 4.2
! Chapter 5
! Chapter 7
! Chapter 8
! Chapter 9
! Chapter 8
! Chapter 9
! Chapter 10

3.2 Procedure for runs with new soil or weather data
Steps:
1.
2.
3.
4.

5.
6.

7.

8.

Start FSEWin
Open the CASE2 model
Configure the CASE2 model
Add new:
− soil data
− weather data
Run the CASE2 model
Obtain model output in:
− table format
− chart format
Export model output (optional)
− table format
− chart format
Close the CASE2 model and end FSEWin

! Section 4.1
! Section 4.2
! Chapter 5
! Section 6.1
! Section 6.2
! Chapter 7
! Chapter 8
! Chapter 9
! Chapter 8
! Chapter 9
! Chapter 10

Chapter 4: Starting CASE2
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Starting CASE2

Steps:
1. Start FSEWin
2. Start CASE2

! Section 4.1
! Section 4.2

4.1 Starting FSEWin
To start FSEWin:
" Double-click on the FSEWin button at the desktop
Or:
" Double-click on the FSEWin.exe file in the directory C:\Program Files\FSEWin\
FSE Windows will start, and you will see the FSEWin screen:

For explanation on the opening window and its menu’s:

! Section 4.3

4.2 Open the CASE2 model
To open the CASE2 model:
" Select “Open project” in the File menu, or Press Ctrl+O, or Click on

.
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The “Open Project” window appears:

" Select the case2.fpf in the C:\CASE2\program directory
" Click on “Open” or, double-click on the case2.fpf file
The case2.fpf is opened and the following screen appears:

All source files, input files, output files and libraries used for the CASE2 model are shown in the left
pane. The following files should be present in the left pane of the FSEWin main screen:
Branch name
Source Files:
Include Files:
Input Datafiles:
Libraries:
Executables:
Output datafiles:

File name
model2.for, fse.for and case2.for
(none)
timer.dat, plant.dat, basic.dat, control.dat, reruns.dat and soil.dat
ttutil.lib, drivers.lib, cacao.lib
(none)
res.dat

Chapter 4: Starting CASE2
Charts
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chart.txt

Now, the CASE2 model can be configured (specifying the location, soil type and cropping system)
and can subsequently be run.
For instructions on configuring CASE2:

! Chapter 5

4.3 The FSEWin main screen
4.3.1 Menu’s and icons
File menu
For use with CASE2 as described in this manual, only four options are used. Their functions are:
Open project:
Opens a project, for instance the CASE2 model. The project (with extension
*.fpf) can be selected in the Open Project window that appears.
Print:
Prints all text in the right pane of the FSE Windows screen to the default printer.
Save all:
Saves all files belonging to the project (all files that are shown in the left pane)
Exit:
Exits FSEWin.
Edit menu
Undo:
Redo:
Cut:
Copy:
Paste:
Select All:
Find:

Find Next:

Reverses the last change made in the text in the right pane. The 10 latest
modifications in the text can be undone.
Repeats the last change made in the text in the right pane. The 10 latest
modifications can be redone.
Removes the selected text from the text in the right pane and moves it to the
clipboard for later use. (The text can be moved elsewhere using “Paste”).
Copies the selected text from the text in the right pane and moves it to the
clipboard for later use. (The text can be moved elsewhere using “Paste”).
Inserts the contents of the clipboard at the position of the cursor in the text.
Selects all text in the right pane.
Searches for characters or words in the text of the right pane. The search text
can be specified in the following window that appears:

Click on “Find” to start the search.
Searches for the next appearance of the text specified in last search.

20
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Run
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Runs the model specified in the project, in this case the CASE2 model. A DOS
screen is invoked in which the time coarse of the simulation can be followed.

4.3.2 Left pane
The left pane (screen part) of the FSEWin main screen contains a list of the files that are used for a
certain project, in the case of CASE2 this is the case2 project. If no project is opened the left pane
contains only file types:

In case the case2 project has been opened (see instructions in Section 4.2), it contains the names
of the files:

Explanation of left pane contents:

Source files
Include files

Indicates that branch of the file tree is expanded (all files and file groups below
this level are shown). To collapse this branch, click on the symbol
Indicates that branch of the file tree is collapsed (no files or file groups below this
level are shown). To expand this branch, click on the symbol.
Branch containing the Fortran source files for the CASE2 model.
Fortran source files should not be edited.
(Not used for the CASE2 model)

Chapter 4: Starting CASE2
Input Datafiles

Libraries
Executables
Output Datafiles
Charts
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Branch containing the data files used by the CASE2 model. The basic.dat file is
used to configure the CASE2 model. The reruns.dat file can be used to specify
multiple model runs (reruns). Two others (soil.dat and timer.dat) can be used to
add new soil or weather data.
The control.dat and plant.dat files should not be edited.
Branch containing the library files used by the CASE2 model. The library files
contain Fortran source files in a different format used by the model.
(Not used for the CASE2 model)
Branch containing a text file with all simulation results and tables with simulation
results for each (re-)run separately.
Branch containing the chart.txt file which provides access to charts in the Chart
screen.

4.3.3 Right pane
The right pane (screen part) of the FSEWin main screen contains the contents of the file selected in
the left pane. Files can be selected in the left pane by clicking on the file name. The selected file is
highlighted in the left pane. For example (basic.dat selected):

The selected file can be edited in the right pane by typing or removing text. The text editing options
in the Edit menu can be used.
Note that only four data files can be edited: basic.dat, reruns.dat and part of soil.dat and
timer.dat. The other files should not be edited. Changing values or text in other files may
corrupt the model, impeding proper model functioning and making model output useless.
In case a “Run_” file is selected in the left pane:

the right pane contains the a table with model output for a specific run (Run 0 is the default run, Run
1 is the first rerun, etc..). For example:

For more information on working with Tables:

! Section 8.1
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Configuring the CASE2 model

Steps:
1. Specify the location
2. Specify the soil type
3. Specify the cropping system
(shade level, age of cacao trees and cacao tree density)
4. Specify the “production level” (potential or water-limited)
5. Specify the output frequency
6. Specify reruns (optional)

! Section 5.1
! Section 5.2
! Section 5.3
! Section 5.4
! Section 5.5
! Section 5.6

5.1 Specifying a location
Weather data for 37 locations in 10 countries are included in the program. There are three types of
weather information: daily weather data, containing weather information on a daily basis and over a
period of several years; monthly weather information containing average data for each month and
for a period of several years; and long-term average weather data containing values for each month
of the year averaged over the month and over a period of usually several decades. The following
scheme explains some of the differences between the three types of weather data:
Type of weather data
Daily weather
Monthly weather
Long-term weather
Data are
specific for:

Each day during a
certain period of
years

Each month during
a certain period of
years

Each month (Jan-Dec), but not for a
certain year.

Data are:

Actual values per
day

Averages or totals
per month, but
specific for one
year

Averages or totals per month, and
also averaged for a number of years

Rainfall is:

Just read from the
file for each day.

Distributed
randomly over the
days in a month
depending on the
number of rain days
and total monthly
rainfall.

Distributed randomly over the days in
a month depending on the number of
rain days and total monthly rainfall.
The monthly total rain and rain days
are furthermore randomly varied
among simulation years (depending
on the average values).

Simulations
may be
carried out:

For only the period
for which data are
available.

For only the period
for which data are
available.

For any period.

Daily weather information is available for 8 locations in 4 countries; monthly data for 10 locations in
4 countries and long-term averages for 19 locations in 8 countries. Table 5.1 lists the 18 locations
for which daily and monthly weather information is included in the model. Table 5.2 contains
information on the 19 locations for which long-term average weather data are available.
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Table 5.1. List of locations for which daily or monthly weather data are included in the model. Nr refers to the
LOCATION number in the basic.dat file. Start year, end year and period refer to the availability of climatic data.
Type refers to the type of weather data for the location: d for daily weather data (CABO weather format) and m
for monthly weather data (WOFOST format).
Nr

Country

Location name

Latitude Longitude Altitude
[degr]

[degr]

[m]

Start

End Period Type

year

year

[y]

1 Brazil

Maceio (Alagoas)

-9.67

-35.7

64.5

1961 1969

9

d

2 Costa Rica

El Carmen

10.2

-83.5

15

1974 1991

18

d

3 Costa Rica

La Lola

10.1

-83.4

40

1973 1990

18

d

4 Costa Rica

La Mola

10.4

-83.8

70

1980 1989

10

d

5 Costa Rica

Puerto Limon

10

-83.1

3

1970 1990

21

d

6 Ghana

Tafo

6.25

-0.4

200

1963 1997

35

m

7 Indonesia

Bah Lias

3.16

99.3

30

1979 1993

15

m

8 Ivory Coast

Abidjan

5.25

-3.93

6

1987 1996

10

m

9 Ivory Coast

Adiake

5.3

-3.3

39

1987 1995

9

m

10 Ivory Coast

Daloa

6.87

-6.4

277

1987 1996

10

m

10 Ivory Coast

Dimbokro

6.65

-4.7

92

1987 1996

10

m

11 Ivory Coast

Gagnoa

6.13

-5.95

214

1986 1997

12

m

12 Ivory Coast

Man

7.38

-7.52

340

1987 1996

10

m

13 Ivory Coast

San Pedro

4.75

-6.6

30

1987 1996

10

m

15 Malaysia

Telok Chengai

16 Papua New

Dami Oil Palm Research

Guinea

6.1

100.3

1

1978 1988

11

m

-5.5

150

5

1970 1991

22

d

14.2

121.3

21

1979 1995

17

d

18

1976 1995

20

d

St.

17 Philippines

IRRI wet station site

18 Philippines

Batac MMSU

18

Table 5.2. List of locations for which long-term weather data are included in the model. Nr refers to the
LOCATION number in the basic.dat file.
Nr

Country

Station

Longitude Latitude

Elevation

[degr.]

[m]

[degr.]

51

Brazil

Belem

-48.47

-1.45

24

52

Brazil

Salvador

-38.33

-12.9

6

53

Brazil

Vitoria

-40.33

-20.32

36

54

Cameroon

Batouri

14.37

4.47

656

55

Cameroon

Douala

9.73

4

9

56

Colombia

Andagoya

-76.67

5.1

65

57

Colombia

Villavicencio

-73.62

4.17

423

58

Ghana

Hon

0.47

6.6

158

59

Ghana

Kumasi

-1.6

6.72

287

60

Ghana

Tafo

-0.4

6.25

200

61

Ivory Coast

Abidjan

-3.93

5.25

6

62

Ivory Coast

Gagnoa

-5.95

6.13

214

63

Ivory Coast

Man

-7.52

7.38

340

64

Malaysia

Kuala Trengganu

103.13

5.33

34

65

Malaysia

Penang

100.27

5.3

4

66

Malaysia

Sandakan

118.07

5.9

12

67

Malaysia

Tawau

5

150

68

Papua New Guinea

Madang

145.78

-5.22

4

69

Papua New Guinea

Rabaul

152.2

-4.22

4
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The location for which simulations are carried out (and the corresponding type of weather data
used) are selected in the basic.dat file. To do so:
" Click on the basic.dat file in the left pane of the FSE Windows main screen. This file is
located in the “Input Datafiles” part of the tree:

The basic.dat file appears in the right pane of the screen
" Go to the following text in Part A of the file:
!---------------------------------!
! Location
!
!---------------------------------!
* Specify location number
* Possible values:
* 1-50 for daily or monthly weather data (1-18 are included with program)
* >50 for long-term weather data (51-69 are included with program)
* For location numbers see the table at end of this file or in the Manual.
LOCATION = 15

" Specify the location for which you wish to run the CASE2 model by editing the number in
the text “LOCATION = <number>”. The LOCATION number corresponds to the number
in Tables 5.1 and 5.2. Location numbers >50 indicate that long-term average weather data
are used. Location numbers 1-50 (of which 1-18 are included in the program) indicate the
use of daily or monthly weather data. An example: if “LOCATION = 2” simulations will be
carried out for El Carmen in Costa Rica, using daily weather data. Note that the number
should not be followed by a period (.).
" Go to the following text in Part A of the file:
!---------------------------------!
! Start and duration of simulation!
!---------------------------------!
*
*
*
*
*

Specify the start year of the simulation (IYEAR) and the number of
years for which simulations should be carried out.
Possible values depend on the availability of weather data for the
location specified above. Please check the Table in the User's Manual
or the Table at the end of this file.
IYEAR
= 1973
NRYEARS = 10
! [y]

" Specify the start year of the simulations by editing the number in the text “IYEAR =
<number>”
For daily or monthly weather data (location numbers 1-50), the start year depends on the
years for which data are available (check the availability of weather data for the location in
Table 5.1 or the table at the end of the basic.dat file). For long-term weather data (location
numbers >50): enter the value 1000.
" Specify the duration of the simulations by editing the number in the text “NRYEARS =
<number>”
For daily or monthly weather data (location numbers 1-50), the possible duration of the
simulation depends on the period for which weather data are available and on the start year
(check the availability of weather data for the location in Table 5.1 or the table at the end of
the basic.dat file). For long-term weather data (location numbers >50): any number of
years may be entered (with a maximum of 37 years as the minimum and maximum ages of
simulated trees are 3 and 40 years, respectively).
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An example: in case LOCATION = 2 the values of IYEAR should not be smaller than 1974
and the value of NRYEARS may in any case not be larger than 18. If for this location 1980 is
chosen as start year (IYEAR) the simulation period (NRYEARS) may not exceed 12. Note that
the numbers for IYEAR and NRYEARS should not be followed by a period (.).

Now, a soil type can be specified:

! Section 5.2

If you wish to add weather data for a new location:

! Section 6.2

5.2 Specifying a soil type
Information on soil texture for three soil types is included in the CASE2 model. The characteristics
of these soil types is described in Table 5.3. Only texture characteristics of the soil types are used
by CASE2 (nutrient limitation is not included in the model). Soil type 1 is a loamy soil with
favourable water-holding capacity. Soil type 2 is a sandy soil, soil type 3 a clayey soil. Both have a
lower water-holding capacity than soil 1. (Most simulations of which results are presented in the
Zuidema & Leffelaar (2002) report are carried out using soil type 1.)
One of the 3 locations should be selected in the basic.dat file. To do so:
" Open the basic.dat file as described in Section 5.1.
" Go to the following text in Part A of the file:
!---------------------------------!
! Soil type
!
!---------------------------------!
* Specify the soil type.
* Possible values: 1-3 for standard soil types (1=Loamy soil,2=Sandy
* soil, 3=Clayey soil, 4-8 for user-defined soils)
SOILTYPE = 1

" Specify the soil type for which you wish to run the CASE2 model by editing the number in
the text “SOILTYPE = <number>”. The SOILTYPE number corresponds to the number
in Table 5.2 An example: “SOILTYPE = 2”. Note that the number should not be followed
by a period (.).
Now, the production level can be specified:

! Section 5.3

If you wish to add soil data for a new soil type:

! Section 6.1
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Table 5.3. A comparison of the characteristics of three soil types of which texture information is available with
the CASE2 model. Soil 1 (SOILTYPE =1) is a loamy soil, data from Nigeria (Wessel 1971). Soil 2 (SOILTYPE
= 2) is a sandy soil present in cocoa planting areas in Rondonia, Brazil. Soil 3 (SOILTYPE = 3) is a clayey soil
present in a plantation in Tawau, Sabah, Malaysia (Table Estate). The percentages sand, silt and clay given for
these soils are translated into texture classes on the basis of the sand-silt-clay triangle (see for example
Driessen 1986). Texture class numbers refer to the Driessen texture classes: 1= Coarse sand; 7= Loamy
medium coarse sand; 8= Loamy fine sand; 9= Sandy loam; 12= Silt loam; 14= Sandy clay loam; 17= Light
clay; 19= Heavy clay. Water content at field capacity (pF=2.0) and wilting point (pF=4.2) are calculated using
the water retention curve (Driessen 1986). Sources: Soil 1 (Wessel, 1971), Soil 2 (Table 3.8 in Wood & Lass
1985), Soil 3 (Table 3.17 in Wood & Lass 1985).
Soil layer

Depth of layer [cm]

Texture class

Water content at
3

-3

field capacity [cm cm ]
Soil 1

Soil 2

Soil 3

Soil 1 Soil 2 Soil 3 Soil 1

Soil 2

Soil 3

3

-3

wilting point [cm cm ]
Soil 1

Soil 2

Soil 3

1

10

9

2

12

1

12

0.359

0.065

0.359

0.108 0.0001 0.108

2

30

14

54

9

7

17

0.273

0.180

0.378

0.044

0.031 0.204

3

30

12

48

8

9

19

0.233

0.273

0.493

0.027

0.044 0.361

4

150

119

52

8

14

19

0.233

0.349

0.493

0.027

0.168 0.361

5.3 Specifying production level
Simulations in CASE2 can be carried out for a potential situation without water limitation and for a
water-limited situation. In the latter case the growth and production of the cocoa crop is limited by
the availability of water in the soil (which depends on rain fall, evapotranspiration and soil
characteristics). Note that for both situations, nutrients are not limiting. This so called “Production
level” can be specified for each simulation.
The production level should be specified in the basic.dat file. To do so:
" Open the basic.dat file as described in Section 5.1.
" Go to the following text in Part A of the file:
!---------------------------------!
! Potential or water-limited
!
!---------------------------------!
* Specify whether simulations should be carried out for a potential
* or water-limited situation.
* Possible values: 1=Potential; 2=Water-limited
PRODLEVL = 2

" Specify the production level: 1 = potential production; 2 = water-limited production. Edit the
number in the text “PRODLEVL = <number>”. Note that the number should not be
followed by a period (.).
Now, the output frequency can be specified:

! Section 5.4

5.4 Specifying output frequency
The output of CASE2 simulations may be generated at different intervals: annually, 10-daily or daily.
Depending on the output frequency, different sets of parameters will be included in the model
output.
The output frequency should be specified in the basic.dat file. To do so:
" Open the basic.dat file as described in Section 5.1.
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" Go to the following text in Part A of the file:
!---------------------------------!
! Output frequency
!
!---------------------------------!
* Specify the frequency at which output is generated in table and
* graph format.
* Possible values: 1=annual output; 2=10-day output; 3=daily output
OUTPUTFQ = 2

" Specify the output frequency: 1 = annual output; 2 = output each 10 days; 3 = daily
output. Edit the number in the text “OUTPUTFQ = <number>”. Note that the number
should not be followed by a period (.).
Now, the cropping system can be specified:

! Section 5.5

5.5 Specifying the cropping system and pod characteristics
5.5.1 Cropping system
Several characteristics of the cocoa cropping system can be specified in the CASE2 model to study
the effects on cocoa growth and yield. These attributes are specified in Part B of the basic.dat file.
To change the cropping system settings:
" Open the basic.dat file as described in Section 5.1.
" Go to Part B of the file:
!======================================================================!
!
!
! PART B. Specify cropping system characteristics here
!
!
(planting density, cacao tree age and shade tree information)!
!
!
!======================================================================!

" And to the cropping system heading:
!---------------------------------!
! Cropping system
!
!---------------------------------!

To change the planting density of cacao trees in the simulated plantation:
" Go to the following text:
* Specify density at which cacao trees are planted in trees per ha.
* Possible values: 700.-2500. Note that number should be followed
* by a period sign (e.g. "1000.").
NPL
= 1000.
! [trees ha-1]

" Specify the planting density in number of cacao trees per ha, within the range of 700-2500.
The standard value used in most simulations reported in Zuidema & Leffelaar (2002) is 1000
ha-1. Make sure that the value contains a period, e.g. “1000.”.
Several characteristics of the shade trees in the simulated plantation can be changed by the user.
-1
To change the leaf area index (the number of leaf layers per unit ground area; in ha leaves ha
ground):
" Go to the following text:
* Specify leaf area index (LAI) of shade trees in ha leaf per ha ground.
* Possible values: 0.-3. Note that number should include
* a period sign (e.g. "1." or "0.2").
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= 0.2
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! [ha leaf ha-1 ground]

" Specify the leaf area index for shade trees in ha leaves per ha soil, within the range of 0.0
(unshaded) – 3.0 (heavily shaded). The standard value used in most simulations reported in
Zuidema & Leffelaar (2002) is 0.2 ha leaves ha-1 ground. Make sure that the value contains
a period, e.g. “1.5”.
Note that the level of shading is determined by both the leaf area index and the extinction
coefficient of the shade trees. The level of shading increases with increasing values of both
parameters. For more background information, see Zuidema & Leffelaar (2002).
To change the extinction coefficient for the leaves of the shade trees (this is the proportion of light
intercepted by one layer of leaves):
" Go to the following text:
* Specify extinction coefficient for shade trees.
* Possible values: 0.4 - 0.8.
SKDFL = 0.6
! [-]

" Specify the extinction coefficient for shade trees, within the range of 0.4 (low light
absorption and high light transmission) – 0.8 (high light absorption and low transmission).
The value for oil palms is typically 0.44. That of most shade trees is between 0.6-0.7. The
standard value used in most simulations reported in Zuidema & Leffelaar (2002) is 0.6.
Make sure that the value contains a period, e.g. “0.44”.
Note that the level of shading is determined by both the leaf area index and the extinction
coefficient of the shade trees. The level of shading increases with increasing values of both
parameters. For more background information, see Zuidema & Leffelaar (2002).
To change the total and lower height of the shade tree canopy:
" Go to the following text:
*
*
*
*
*

Specify height of the shade tree canopy in m. SHGHL for height of lower
canopy boundary; SHGHT for height of upper canopy boundary
Possible values: 0.-40. Note that number should include
a period sign (e.g. "5." or "7.5").
Note that SHGHL should be less than SHGHT
SHGHL = 4.0
! [m] Lower height of shade tree crowns
SHGHT = 10.
! [m] Upper height of shade tree crowns

" Specify the lower height (SHGHL) and total height (SHGHT) of the shade tree canopy in
meters. The lower height may not be larger than the total height and both heights should
not exceed 40 m (higher values are unrealistic). The standard value used in most
simulations reported in Zuidema & Leffelaar (2002) is 4.0 m for the lower height and 10
meter for the upper height. Make sure that the value contains a period, e.g. “4.0”.
Note that in the CASE2 model, canopies of cacao trees and shade trees may overlap, as is the
case in real cacao plantations in some cases. Canopies overlap when the range of lower and
total height of the shade tree overlaps with that of the cacao tree (see instructions below in
Section 5.5.2).

5.5.2 Cacao tree input
Several characteristics of the cacao tree can be specified in the CASE2 model to study the effects
on cocoa growth and yield. These attributes are specified in Part B of the basic.dat file.
To change the cacao input settings:
" Open the basic.dat file as described in Section 5.1.
" Go to Part B of the file:
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!======================================================================!
!
!
! PART B. Specify cropping system characteristics here
!
!
(planting density, cacao tree age and shade tree information)!
!
!
!======================================================================!

" And to the cacao tree heading:
!---------------------------------!
! Cacao tree
!
!---------------------------------!

Model simulations should start with a cacao tree of a certain size or age. A switch parameter
determines whether size or age is used as input for model initialisation.
To specify the age-size switch:
" Go to the following text:
*
*
*
*

Specify whether tree size or age is used for initial input
Both plant size (biomass) and plant age can be used as input.
The switch parameter SWINPUT determines which of the two is used.
Possible values: 1=age is used as input; 2=size is used as input.
SWINPUT = 1
![-]

" Specify the switch by putting 1 in case the initial age will be used as input or 2 in case the
initial biomass (dry weight) will be the input. Make sure that the value does not contain a
period, e.g. “1”.
Depending on the choice for SWINPUT, either the initial tree age (SWINPUT = 1) or the initial tree
biomass (SWINPUT = 2) should be specified.
If SWINPUT = 1, specify the initial tree age:
" Go to the following text:
*
*
*
*

Specify initial tree age in years.
Note: this value is only used in case SWINPUT = 1
Possible values: 3. - 40. Note that number should include
a period sign (e.g. "5." or "12.5").
AGEIYR = 4.11
! [y]

" Specify the initial age in years. The value should be within the range of 3-40 y, as the model
does not perform well at lower or higher ages. The value used in many of the simulations
reported in Zuidema & Leffelaar (2002) is 4.11 y (or 1500 days). Make sure that the value
contains a period, e.g. “5.”.
If SWINPUT = 2, specify the initial tree age:
" Go to the following text:
*
*
*
*

Specify initial tree size (biomass per tree).
Note: this value is only used in case SWINPUT = 2
Possible values: 18.5 - 70.0. Note that number should include
a period sign (e.g. "20." or "22.5").
WTOTI
= 18.5
![kg DW tree-1]; NOTE: Minimum size=18.5 kg

" Specify the initial total biomass in kg dry weight. The value should be within the range of
18.5-70 kg, as the model does not perform well at lower or higher weights. Make sure that
the value contains a period, e.g. “20.”.

5.5.3 Pod characteristics and processing
Several characteristics related to the pods and processing of beans may be changed in the CASE2
model to study their effects on cocoa growth and yield. These attributes are specified in Part B of
the basic.dat file.
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To change the pod and processing characteristics:
" Open the basic.dat file as described in Section 5.1.
" Go to Part B of the file:
!======================================================================!
!
!
! PART B. Specify cropping system characteristics here
!
!
(planting density, cacao tree age and shade tree information)!
!
!
!======================================================================!

" And to the pod characteristics and processing heading:
!------------------------------------!
! Pod characteristics and processing !
!------------------------------------!

Nib fat content has an influence on the assimilate requirements (“costs”) to produce a kg of cacao
beans (assimilate requirements increase with increasing fat content). The effect of fat content on
bean yield can be investigated by changing the fat content value.
To change the fat content:
" Go to the following text:
* Specify the fat content of nibs
* The standard value is 0.55 (Wood and Lass 1985)
FATCONTENT = 0.55
![-]

" Specify the fat content within the range of 0.5-0.6. The standard value used in all
simulations reported in Zuidema & Leffelaar (2002) is 0.55.
The fraction beans in one pod may vary among cacao varieties and cultivars. The effect of this
fraction on beans yield can be investigated by changing its value.
To change the fraction beans per pod:
" Go to the following text:
* Specify the fraction of beans per pod
* The standard value is 0.55
FBEANS = 0.55

![-]

" Specify the fraction beans. The standard value used in all simulations reported in Zuidema &
Leffelaar (2002) is 0.55.
The pod index or pod value denotes the number of pods required for one kg of beans. In the model,
this value has an effect on the amount of pods produced (HARPODS).
To change the pod value:
" Go to the following text:
* Specify the pod index or pod value
* This is the number of pods needed for one kg of dry beans
* The standard value is 30.
PODVALUE = 30.
![kg-1 DW]

" Specify the pod value. The standard value used in all simulations reported in Zuidema &
Leffelaar (2002) is 30. Other values range from 16-24 (Wood & Lass 1985, Teoh et al. 1986,
Yapp & Hadley 1994).
During fermentation, the dry weight of beans decreases. The degree to which weight is lost
depends on the duration of the fermentation period.
To change the length of the fermentation period:
" Go to the following text:
* Specify the fermentation duration in hours.
* The standard value is 5.(Humphries, 1944)
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FMTDUR

= 5.

![d]

" Specify the fermentation duration in days. The value should be within the range of 1-10
days. The standard value used in all simulations reported in Zuidema & Leffelaar (2002) is 5
days.
Dry and fermented beans in reality still contain a certain percentage of moisture. The dry weight of
beans calculated in CASE2 should be changed to account for the bean moisture content.
To change the moisture content of dry beans:
" Go to the following text:
* Specify the moisture content of the beans
* The standard value is 0.075 (Wood & Lass 1985)
MOISTC = 0.075
![-]

" Specify the moisture content as a fraction. The value should be within the range of 5-8 %.
The standard value used in all simulations reported in Zuidema & Leffelaar (2002) is 0.075.

5.6 Specifying reruns
With the standard model run procedure in CASE2, one simulation run is carried out at a time, using
one set of input parameters. Using the reruns option, several model runs can be carried out using
different values for certain input parameters. For instance, shade levels can be varied at three
levels, or model runs can be carried out for different soil types. When reruns are done, several sets
of output parameters are generated and model output of these runs can be compared in tables and
combined in charts.
Reruns are specified in the reruns.dat file by putting the value of one or more input parameters (see
instructions below). For each of the reruns specified in reruns.dat, an extra model run is performed.
Thus, after the run using values specified in the basic.dat file as many extra runs as specified in
reruns.dat will be performed. The output of the first default run is called “Run 0”, the output for the
reruns “Run 1” for the first specified rerun, “Run 2” for the second, etc. For each run, a separate
table with results is produced. Output of several runs can be combined in one chart using the Runstab in the chart screen (see Section 9.3 for instructions).
For instruction on the use of the example reruns
For instruction on specifying new reruns

! Section 5.6.1
! Section 5.6.2

5.6.1 Using the example reruns
The reruns.dat file delivered with the CASE2 model already contains some example reruns.
To specify reruns, first open the reruns.dat file:
" Click on the reruns.dat file in the left pane of the FSE Windows main screen. This file is
located in the “Input Datafiles” part of the tree:
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The reruns.dat file appears in the right pane of the screen
" Go to Part A of the file:
!======================================================================!
!
!
! PART A. EXAMPLE RERUNS
!
!
To use one of the example reruns, simply remove the “*”-sign !
!
at the start of the line. Do not forget to place an “*” again!
!
when you do not wish to do reruns for that parameter.
!
!======================================================================!

To carry out a rerun with a different production level:
" Go to the following text:
!---------------------------------!
! Production level
!
!---------------------------------!
*When removing the * in the below line, an extra run will be performed
*for PRODLEVL = 1 (potential production).
*PRODLEVL = 1

" Remove the “*” sign from the last line of the above text. Make sure that there are no other
lines without a “*” sign as in this case more reruns will be done. To de-activate a line in the
reruns.dat file, put an “*” sign as the first character of the line.
To carry out reruns with different soil types:
" Go to the following text:
!---------------------------------!
! Soil type
!
!---------------------------------!
*When removing the * in the below lines, 2 extra runs will be performed
*for SOILTYPE = 2 and 3 (sandy and clayey soils).
* SOILTYPE = 2
* SOILTYPE = 3

" Remove the “*” signs from the last two lines of the above text. Make sure that there are no
other lines without a “*” sign as in this case more reruns will be done. To de-activate a line
in the reruns.dat file, put an “*” sign as the first character of the line.

5.6.2 Specifying new reruns
New reruns may be specified in reruns.dat file. Follow the instructions below or use one of the
example reruns as guidance.
To specify new reruns, first open the reruns.dat file:
" Click on the reruns.dat file in the left pane of the FSE Windows main screen. This file is
located in the “Input Datafiles” part of the tree:

The reruns.dat file appears in the right pane of the screen.
" Go to Part B of the file:
!======================================================================!
!
!
! PART B. USER-DEFINED RERUNS
!
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!
To add a user-defined rerun, simply write one line of the
!
!
type:
<PARNAME> = <VALUE>
!
!
in which <PARNAME> is the name of an input parameter and
!
!
<VALUE> is the value for which a rerun is wanted.
!
!
To de-select the rerun, simply put an "*" mark in front of
!
!
the line. More instructions in the User's manual
!
!======================================================================!

" Go to a new line below the above text.
" Put a “*” sign followed by an explanation of the input parameter used for this rerun.
For example, if the rerun is carried out for different initial cacao tree age:
* Reruns for different start age (AGEYR)

" Go to the next line
" Put the name of the input parameter, followed by a “=” sign and the value for the input
parameter. For example, if the rerun is carried out for different initial cacao tree age:
AGEIYR = 10.

Any input parameter that is used in the basic.dat file can be used for a rerun. Note that for
some input parameters, a period should be included in the value (e.g. for AGEIYR: “10.” is
correct, but “10” is not), whereas for others no period should be included (e.g. for PRODLEVL:
“1” is correct but “1.” is not). It is recommended to check whether the value for the input
parameter specified in the reruns.dat file is actually different from that in the basic.dat file. If
this is not the case, the output of the two reruns will be exactly the same.
" Repeat the instructions in the above two paragraphs in case you wish to carry out more
than one rerun. For example, if the rerun is carried out for three different ages:
AGEIYR = 10.
AGEIYR = 15.
AGEIYR = 20.

More input parameters can be changed for one rerun. To do so, put two or more statements for
input parameters on the same line. Separate statements with a “;”. For example:
SOILTYPE = 2.; PRODLEVL = 2
SOILTYPE = 3.; PRODLEVL = 2
SOILTYPE = 1.; PRODLEVL = 1

In this case, three reruns will be carried out: one for soil type 2 under water-limited conditions, one
for soil type 3 under water-limited conditions and one for soil type 1 for potential production (not
water-limited).
When combining input parameters in reruns, all input parameters should be included in each of the
rerun lines. The following rerun specification is wrong:
SOILTYPE = 2.
SOILTYPE = 3.
SOILTYPE = 1.; PRODLEVL = 1
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Adding new soil or weather data

Choice:
1. Add a new soil type
2. Add weather data for a new location

! Section 6.1
! Section 6.2

6.1 Adding a new soil type
New soil types may be added to the soil.dat data file. Three types of parameters should be specified
for a soil type: the number of soil layers; the thickness of all soil layers and the texture type
(following the Driessen texture classes) per soil layer. Note that the total soil depth (the sum of the
thickness of all layers should not be smaller than 1.5 m. It is recommended to keep the number of
layers between 3-6 layers, as a lower or higher number of layers may result in unrealistic simulation
of the soil water balance.
To add a soil type:
" Click on the soil.dat file in the left pane of the FSE Windows main screen. This file is located
in the “Input Datafiles” part of the tree:

The soil.dat file appears in the right pane of the screen.
" Go to Part A of the file:
!======================================================================!
!
!
! PART A. Information may be added to this part of the file.
!
!
Please follow the instructions in the User's Manual
!
!
!
!======================================================================!

" And then to the first soil type for which only zero’s are specified as parameter values (in the
standard soil.dat file delivered with the CASE2 model, this is Soil type 4):
* < specify type of soil and information source here >
* < specify country and area here >
NL4
= 0
! Number of layers
TKL4
= 0., 0., 0., 0.
! Thickness of layers (m)
TYL4
= 0., 0., 0., 0.
! Driessen texture classes for layers

" Specify the type of soil and the information source in the first line. Specify the country and
area from which the data were obtained, if applicable, on the second line. The “*” sign
should be maintained at the first position on both lines to prevent model errors. For
instance:
* Clayey soil taken from Wood & Lass(1985), Table 3.17
* Malaysia, Tawau

" Change the “0” value for the NL.. parameter to the right number of soil layer.
" Specify the thickness of the soil layers (in meter) following “TKL.. = “ by replacing the zero
values. The first value is for the uppermost (top) soil layer. Make sure that each value
contains a period, e.g. “1.0”. Note that the sum of all soil layers should be at least 1.5 m. A
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reasonable build-up of soil layers is 0.15, 0.25, 0.50 and 0.60 cm thickness for the first
through the fourth layer, but this may be adapted to the horizons observed in the field.
" Specify the texture type for the layers following “TYL.. = “ by replacing the zero values. The
first value is for the uppermost (top) soil layer. Make sure that each value is followed by a
period, e.g. “9.0”. A list with possible types is included in Table 6.1.
Now, save the changes to the timer.dat file:
" Press the
button, or select “Save all” in the File menu, or press Ctrl+S

Table 6.1. Description and characteristics of Driessen soil texture types as used in the soil.dat file. The code
refers to the value of the TYL.. parameter. Gamma (γ) is a texture-specific constant describing the waterretention curve (Driessen 1986). Water content is the volumetric percentage of water in the soil at different
amounts of suction pressure. Source: Driessen 1986.
Code Description

Gamma

Water content at
Saturated

1

Coarse sand

2

Medium coarse sand

3
4

field capacity wilting point

air dry

0.0853

39.5%

6.5%

0.0%

0.0%

0.045

36.5%

14.1%

0.5%

0.0%

Medium fine sand

0.0366

35.0%

16.1%

1.1%

0.0%

Fine sand

0.0255

36.4%

21.2%

3.3%

0.0%

5

Humous loamy medium coarse sand

0.0135

47.0%

35.3%

13.3%

1.4%

6

Light loamy medium coarse sand

0.0153

39.4%

28.5%

9.4%

0.7%

7

Loamy medium coarse sand

0.0243

30.1%

18.0%

3.1%

0.1%

8

Loamy fine sand

0.0299

43.9%

23.3%

2.7%

0.0%

9

Sandy loam

0.0251

46.5%

27.3%

4.4%

0.1%

10

Loess loam

0.0156

46.5%

33.4%

10.8%

0.8%

11

Fine sandy loam

0.0186

50.4%

34.0%

8.8%

0.4%

12

Silt loam

0.0165

50.9%

35.9%

10.8%

0.7%

13

Loam

0.0164

50.3%

35.5%

10.8%

0.7%

14

Sandy clay loam

0.0101

43.2%

34.9%

16.8%

3.1%

15

Silty clay loam

0.0108

47.5%

37.8%

17.3%

2.9%

16

Clay loam

0.0051

44.5%

39.9%

27.6%

11.8%

17

Light clay

0.0085

45.3%

37.8%

20.4%

5.0%

18

Silty clay

0.0059

50.7%

44.7%

29.2%

10.9%

19

Heavy clay

0.0043

54.0%

49.3%

36.1%

17.7%

20

Peat

0.0108

86.3%

68.6%

31.4%

5.2%

6.2 Adding weather data for a new location
Weather data for new locations can be used by the CASE2 model. Three types of weather data
may be used: (1) daily weather, (2) monthly weather data and (3) long-term weather data. Daily
weather data (CABO weather format) contain information on rainfall, radiation, vapour pressure and
temperature for every day. Monthly data (WOFOST weather format) contain average values for
radiation, temperature, vapour pressure and total values for rainfall for one month. In the latter case,
the monthly summary values are used to generate daily values for all weather parameters (using
interpolation in the case of monthly averages and random generation of daily values in the case of
rainfall). In both cases, weather data should be available for a number of consecutive years,
preferably 10 or more years. For long-term weather data, on the other hand, the information is not
specific for one year but an average over a (large) number of years. The average values are valid
for one month. Thus, 12 values are included for each weather parameter.
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For the three types of weather data, there are certain physical boundaries defined for the model.
Altitude should not exceed 1400 m; average day temperature should not be outside the 10-40ºC
-1
range and average annual precipitation should be higher than 1250 mm yr .
Weather data are stored in separate data files. For daily weather data, one year of weather
information is stored in one file. For monthly weather data, the information of all years is stored in
one file. For long-term weather data, the information is also stored in one file. To add weather data
to the CASE2 model, data files containing the actual data should be available and placed in the
correct directory. Secondly, reference to the new weather files should be made in the timer.dat file.
For instructions on adding daily weather data
For instructions on adding monthly weather data
For instructions on adding long-term weather data

! Section 6.2.1
! Section 6.2.2
! Section 6.2.3

6.2.1 Daily weather
To add new daily weather data, a text file (ASCII format) should be made for each year. The
extension of the file name are the three last numbers of the year (e.g. .989 for the year 1989). File
names should be build from a country code in 3 letters (e.g. idn or Indonesia) and a station number
of one or two numbers (e.g. 24). Official country codes can be found in Stol (1994). The weather file
for weather station 24 in Indonesia for the year 1989 would then be: “idn24.989”. Daily weather
data files should be stored in the c:\case2\weather\daily directory.
A daily weather data file for one year should contain the following information in the following order:
File header:

a continuous block of lines that start with a <*> in the first column. The file header
contains general information about the data and their origin.
line 1:
(the first line below the header) the longitude, latitude, altitude for the site and the
coefficients A and B for the Angstrom formula. The last two parameters are only
required when global radiation is derived from sunshine duration. Put values 0.0 in
case the Angstrom coefficients should not be used.
line 2-367:
daily weather data; one line per day.
in these lines: Column 1: station number
Column 2: year
Column 3: Julian day number
-2 -1
-1
Column 4: irradiation (kJ m d ) or sunshine duration (h d )
Column 5: minimum temperature (°C)
Column 6: maximum temperature (°C)
Column 7: early morning vapour pressure (kPa)
-1
Column 8: mean wind speed at 2 m above ground level (m s )
-1
Column 9: precipitation (mm d )
Notes:

- The values should be separated by at least one space character.
- Day numbers range from 1-365, and in the case of leap years to 366
- Missing values should be indicated by the value “-99”; some missing values are
allowed (see van Kraalingen et al. 1990). Wind speed may be missing as it is not
used in CASE2.

An example of part of a daily weather data file for Bah Lias Estate (North Sumatra, Indonesia) is
shown below:
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*---------------------------------------------------------*
*
Country: Indonesia
*
Station: Bah Lias
*
Year: 1989
…
*---------------------------------------------------------*
99.3 3.16 30.0 0.00 0.00
3 1989
1 10627 21.7 28.9 2.757 1.01
0
3 1989
2 13190 22.4 30.9 2.923 0.74
0
3 1989
3 12046 23.3 31.3 3.034 0.57
9
.
.
.
3 1989 364 16146 21.9 30.8 2.851 1.08
4
3 1989 365 17413 22.7 32.1 2.979 0.90
25

Reference to the new weather files should be made in the timer.dat file:
" Click on the timer. dat file in the left pane of the FSE Windows main screen. This file is
located in the “Input Datafiles” part of the tree:

The timer.dat appears in the right pane of the screen.
" Go to the location specification heading in Part A of the file:
!======================================================================!
!
!
! PART A. Information may be added to this part of the file.
!
!
Please follow the instructions in the User's Manual
!
!
!
!======================================================================!
!---------------------------------!
! Location specifications
!
!---------------------------------!

" And then below the “ Daily or monthly weather data” heading to the first location number
for which only zero’s are specified as parameter values (in the standard timer.dat file
delivered with the CASE2 model, this is Location 19):
* LOCATION 19
* < specify location name and period of weather data here >
WTRDIR19 = ' '
CNTR19
= ' '
CLFILE19 = ' '
ISTN19
= 0
IWEATH19 = 0
IRNDAT19 = 0
STRTYR19 = 0
ENDYR19 = 0

" Specify the weather directory between quotation marks. This should be:
WTRDIR19 = 'c:\case2\weather\daily'

" Specify the country code (CNTR..), that is, the first three letters of the file names for this
weather station. For instance idn if the file name is idn24.989:
CNTR19 = 'idn'

" The following line (for CLFILE..) can be skipped, as this does not apply to daily weather
data. Leave the text as is:
CLFILE19 = ' '
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" Specify the station number (ISTN..), that is, the first three letters of the file names for this
weather station. For instance 24 if the file name is idn24.989:
ISTN19 = 24

" Specify the type of weather data (IWEATH..). This should be 2 for daily weather data:
IWEATH19 = 2

" Specify the type of rainfall data (IRNDAT..). This should be 2 for daily weather data:
IRNDAT19 = 2

" Specify the first year of the consecutive period for which weather data are available
(STRTYR..). For instance 1989:
STRTYR19 = 1989

" Specify the last first year of the consecutive period for which weather data are available
(STRTYR..). For instance 1999:
ENDYR19 = 1999

Now, save the changes to the timer.dat file:
" Press the
button, or select “Save all” in the File menu, or press Ctrl+S

6.2.2 Monthly weather
To add new monthly weather data, one text file (ASCII format) should be made including weather
data for all years. The extension of the file name is usually *.wof. File names should preferably not
exceed 8 characters (e.g. indjava.wof or indo24.wof). Monthly weather data files should be stored in
the c:\case2\weather\monthly directory.
A monthly weather data file for should contain the following information in the following order:
Line 1:
name and number of the weather station (comment line)
line 2:
year of observation, latitude of location, altitude of the location
line3-14:
average monthly weather data; one line per month, from January to December
in these lines: Column 1: minimum temperature (°C)
Column 2: maximum temperature (°C)
-2 -1
Column 3: irradiation (MJ m d )
Column 4: vapour pressure (hPa[mbar])
-1
Column 5: windspeed (m s )
-1
Column 6: precipitation (mm month )
-1
Column 7: number of rain days (month )
Notes:

- The values should be separated by at least one space character.
- Temperatures, irradiation, vapour pressure and windspeed are monthly averages
- Rainfall is the monthly total
- Number of rain days is the actual number of rain days per month
- Missing values are not allowed, except for wind speed as this is not used in
CASE2

An example of part of a monthly weather data file for Gagnoa in Ivory Coast is shown below:
Côte d'Ivoire/Gagnoa
1987
6.06
214.00
19.70
33.30
15.16
22.00
34.49
15.88
22.13
33.31
17.57
22.04
32.98
17.77
22.50
31.94
17.08
21.92
30.22
13.43
21.39
28.85
14.25
21.31
28.82
13.51

28.07
27.00
28.40
30.18
29.86
28.89
25.97
28.63

0.00
0.00
0.00
0.00
0.67
1.00
0.67
0.33

14.
105.
109.
192.
87.
148.
69.
159.

4.
9.
10.
12.
11.
12.
11.
17.
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21.70
29.78
14.68
21.89
30.90
17.03
21.93
31.59
16.02
21.19
31.43
14.63
Côte d'Ivoire/Gagnoa
1988
6.06
214.00
19.70
33.30
15.77
22.00
34.49
16.23
22.13
33.31
17.10
22.04
32.98
16.89
22.50
31.94
17.95
21.92
30.22
14.31
21.39
28.85
14.08
21.31
28.82
11.36
21.70
29.78
14.92
21.89
30.90
16.86
21.93
31.59
15.56
21.19
31.43
15.29

28.71
29.07
28.91
26.20

1.33
1.00
2.00
0.00

347.
123.
78.
6.

19.
17.
5.
1.

24.17
26.11
27.33
28.62
28.75
28.04
26.43
26.43
26.93
27.72
28.26
26.90

0.67
1.00
0.33
0.33
0.00
2.33
1.00
1.00
1.00
0.00
0.00
0.00

2.
28.
176.
130.
128.
202.
33.
114.
411.
90.
82.
25.

1.
1.
8.
5.
7.
10.
6.
8.
15.
4.
8.
4.

Reference to the new weather files should be made in the timer.dat file:
" Click on the timer. dat file in the left pane of the FSE Windows main screen. This file is
located in the “Input Datafiles” part of the tree:

The following file appears in the right pane of the screen.
" Go to the location specification heading in Part A of the file:
!======================================================================!
!
!
! PART A. Information may be added to this part of the file.
!
!
Please follow the instructions in the User's Manual
!
!
!
!======================================================================!
!---------------------------------!
! Location specifications
!
!---------------------------------!

" And then below the “ Daily or monthly weather data” heading to the first location number
for which only zero’s are specified as parameter values (in the standard timer.dat file
delivered with the CASE2 model, this is Location 19):
* LOCATION 19
* < specify location name and period of weather data here >
WTRDIR19 = ' '
CNTR19
= ' '
CLFILE19 = ' '
ISTN19
= 0
IWEATH19 = 0
IRNDAT19 = 0
STRTYR19 = 0
ENDYR19 = 0

" Specify the weather directory between quotation marks. This should be:
WTRDIR19 = 'c:\case2\weather\monthly'

" The following two lines (CNTR.. and CLFILE.. ) can be skipped, as they only apply to daily
weather data. Leave the text as is:
CNTR19 = ' '
ISTN19 = 0
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" Specify the file name (CLFILE..) between quotation marks, and ending with the *.wof
extension. For example:
CLFILE19 = 'indo24.wof'

" Specify the type of weather data (IWEATH..). This should be 1 for monthly weather data:
IWEATH19 = 1

" Specify the type of rainfall data (IRNDAT..). This should be 1 for monthly weather data:
IRNDAT19 = 1

" Specify the first year of the consecutive period for which weather data are available
(STRTYR..). For instance 1989:
STRTYR19 = 1989

" Specify the last year of the consecutive period for which weather data are available
(ENDYR..). For instance 1999:
ENDYR19 = 1999

Now, save the changes to the timer.dat file:
" Press the
button, or select “Save all” in the File menu, or press Ctrl+S

6.2.3 Long-term weather
To add new long-term weather data, one text file (ASCII format) should be made. The extension of
the file name is usually *.ltm or *.avg or *.000. File names should preferably not exceed 8
characters (e.g. indjava.ltm or indo24.ltm). Long-term weather files should be stored in the
c:\case2\weather\longterm directory.
A long-term weather data file for should contain the following information in the following order:
Line 1:
name and number of the weather station (comment line)
line 2:
year of observation (always 1000), latitude of location, altitude of the location, A and
B coefficients for the Angstrom formula (these coefficients are not used in the
current version of CASE2 and therefore do not have to be specified)
line3-14:
average monthly weather data; one line per month, from January to December
in these lines: Column 1: minimum temperature (°C)
Column 2: maximum temperature (°C)
-2 -1
Column 3: irradiation (MJ m d )
Column 4: vapour pressure (hPa[mbar])
-1
Column 5: wind speed (m s )
-1
Column 6: precipitation (mm month )
-1
Column 7: number of rain days (month )
Notes:

- The values should be separated by at least one space character.
- Temperatures, irradiation, vapour pressure and windspeed are averages per
month and over a period of years
- Rainfall is the monthly total, averaged over a number of years
- Number of rain days is the number of rain days per month, averaged over a
number of years
- Missing values are not allowed, except for wind speed as this is not used in
CASE2

An example of part of a long-term weather file for Abidjan in Ivory Coast is shown below:
*---------------------------------------------------------*
*
Country: Brazil
*
Station: Belem
*
Year: Long-term Climatic Data
*
Source: FAOCLIM Global Weather Database - Release
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*
20 July 1990.
*
Author: Agrometeorology group, Remote Sensing Centre,
*
Research and Technology Division, FAO.
* Longitude: 048 28 W
* Latitude: 01 27 S
* Elevation: 24 m.
* WMO-code: 82.1910
* Comments: Number of rain days added from Mueller database
*
February 2002, Pieter Zuidema
*
* Columns:
* ========
* minimum temperature (degrees Celsius)
* maximum temperature (degrees Celsius)
* irradiation (MJ m-2 d-1)
* vapour pressure (kPa)
* mean wind speed (m s-1)
* precipitation (mm month-1)
* number of rain days
*---------------------------------------------------------*
Belem
Brazil
1000
-1.45
24.
0.00
0.00
22.6
31.0
16.998 2.84
0.6
325.
27.
22.7
30.4
15.910 2.86
0.6
406.
26.
22.8
30.3
15.952 2.88
0.6
429.
28.
23.0
30.8
16.412 2.92
0.6
318.
27.
22.9
31.4
17.710 2.90
0.7
296.
26.
22.5
31.8
18.799 2.81
0.8
153.
22.
22.2
31.7
20.055 2.75
0.8
138.
17.
22.1
32.0
21.143 2.78
0.9
119.
15.
22.0
31.9
21.604 2.78
0.8
131.
18.
22.0
32.0
22.148 2.81
0.9
110.
15.
22.1
32.2
21.311 2.81
1.0
114.
13.
22.4
31.8
19.845 2.83
0.8
196.
19.

Reference to the new weather files should be made in the timer.dat file:
" Click on the timer. dat file in the left pane of the FSE Windows main screen. This file is
located in the “Input Datafiles” part of the tree:

The following file appears in the right pane of the screen.
" Go to the location specification heading in Part A of the file:
!======================================================================!
!
!
! PART A. Information may be added to this part of the file.
!
!
Please follow the instructions in the User's Manual
!
!
!
!======================================================================!
!---------------------------------!
! Location specifications
!
!---------------------------------!

" And then below the “ Long-term weather data” heading to the first location which no
information and file name are specified (in the standard timer.dat file delivered with the
CASE2 model, this is Location 70)o to the location specification heading in Part A of the file:
* LOCATION 70
* < specify location name and period of weather data here >
CLFILE70 = ' '
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" Specify the country and station name in the second line and file name (CLFILE..) on the
third line between quotation marks (file names may have extensions *.ltm, *.avg or *.000).
For example:
* Ivory Coast, Station 100
CLFILE70 = 'Civ100.ltm'

Now, save the changes to the timer.dat file:
" Press the
button, or select “Save all” in the File menu, or press Ctrl+S
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Running the CASE2 model

7.1 Running the model
To run the CASE2 model:
" Click on
, or choose “Run” from the Run menu, or Press F9
FSEWin now prepares the model to run. This may take some time, depending on the type of
computer and on the configuration of the CASE2. During the model run, a DOS screen is
invoked in which the time coarse of the simulation can be followed. An example of the DOS
screen:

" Check the DOS screen for any warning or error messages. A list of possible warning and
error messages is included in Appendix II. A Warning message that will always be shown is
“WARNING from DRSAHE: initial soil moisture in hydrostatic equilibrium not implemented.
Instead, field capacity is used.” This implies that water availability at the start of the model
run is assumed to be optimal (water content at field capacity). This should be kept in mind
in the interpretation of the model output for the first few days.
When the text “Press any key to continue” appears:
" Press any key
" Click on the
button in the right upper corner of the DOS screen to close it.
Or:
" Press Alt+F4
The DOS window closes and you return to the FSEWin main screen.
Now, the new simulation results can be viewed. Note that in case error messages were issued
during the model run, no output is generated. See Section 11.1 for information on error and warning
messages in the DOS screen.
For information on running the CASE2 model with reruns
To view the table output of the last simulation run:
To view the chart output of the last simulation run:

! Section 7.2
! Section 8.1
! Chapter 9
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7.2 Reruns
In case reruns have been defined in the reruns.dat file (see Section 5.6 on how to specify reruns),
reruns will be automatically performed in the order indicated in the reruns.dat file. Follow the normal
procedure to run the model (see Section 7.1).
In the DOS window lines for reruns will start with the text “Rerun set: “ followed by the number of
the rerun. The following DOS screen is an example of model simulations with one rerun: the time
information on the normal run is indicated by the text “Default set,”, whereas that for the rerun is
labelled “Rerun set: 1, “.

For information on viewing table output of different reruns:
For information on obtaining charts for different reruns:

! Section 8.1
! Section 9.3
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Model output in tables

Choice:
1. Model output in table format
2. Exporting tables to Excel

! Section 8.1
! Section 8.2

8.1 Model output in table format
To obtain model output in table format:
" Select a “Run_” file in the left pane of the FSEWin main screen. For instance:

Run_0 refers to the default run, Run_1 to the first rerun, etc., Run_2 to the second rerun, etc.
The output will be shown in a table. If no reruns have been specified in the reruns.dat file, only
RUN_0 will be shown. An example of a table:

The time steps (rows) at which output is shown as well as the parameters for which output is
shown (columns) depend on the specification of the output frequency (see Section 5.4).
For instructions on exporting table information to Excel:
For explanation on output parameters in tables

! Section 8.2
! Appendix I

8.2 Exporting tables to Excel
FSEWin tables can be exported to Excel in a simple way.
To export a Table to Excel,
" Select a “Run_” file in the left pane of the FSEWin main screen. For instance, Run_0:

" Click on any cell within the table
" Click on the
button, or select “Copy” from the Edit menu, or press Ctrl+C
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" Go to an open Excel sheet
" Select the cell where the left-upper corner of the table should be located
" Click on the
button, or select “Paste” from the Edit menu, or press Ctrl+V
The entire table including headings with the parameter names will be copied to the Excel sheet.

This procedure can be repeated for different reruns.
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Model output in charts

Steps:
1.
2.
3.
4.
5.
6.

Open the chart screen
Select parameters
Select reruns (optional)
Zooming in a chart (optional)
Copy chart as a picture (optional)
Close the chart screen

! Section 9.1
! Section 9.2
! Section 9.3
! Section 9.4
! Section 9.5
! Section 9.6

9.1 Opening the chart screen
To open de chart screen:
" Click on the chart.txt file name below the Charts branch in the left pane:

The chart screen appears on top of the FSEWin main screen:

The list of parameters included in this screen depends on the output frequency specified in
basic.dat (see Section 5.4).
For more information on menu’s and icons in the chart screen:
For instruction on selecting parameters for the chart
In case the following window appears in the chart screen:

! Section 4.3
! Section 9.2
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the last model simulation has not been successful. Probably an error occurred during model
execution, and no output was generated. To obtain model output, the error has to be resolved (see
Section 11.1 for explanation on error messages and Appendix II for a list of error messages and
their possible solutions).

9.2 Selecting parameters for a chart
Model output of different parameters can be combined in charts. Parameters can be selected and
de-selected. Note that the z-axis cannot be used.
First, make sure the “Axes” tab is selected in the chart screen. That is, the “Axes” tab should be in
front of the “Rerun” tab:

If this is not the case:
" Click on the word “Axes”
Then, follow the instructions depending on what you wish to do:
To select and de-select x-axis parameters
!A
To select y-axis parameters
!B
To select additional y-axis parameters
!C
To de-select y-axis parameters
!D
A. Select and de-select x-axis parameters
To select the parameter for the x-axis:
" Choose which of the parameters in the list should be on the x-axis
" Click on cell in the “X” column pertaining to that parameter to place the “#” mark in that
cell.
For example, in case “YEAR” is chosen as x-axis variable, the first lines will look like:

To de-select a parameter:
" Click on cell in the “-” column pertaining to the selected parameter to place the “#” mark in
that cell.
For example, in case “YEAR” is de-selected as x-axis variable, the first lines will look like:

To change the x-axis parameter:
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" Choose which of the parameters in the list should be on the x-axis
" Click on cell in the “X” column pertaining to that parameter to place the “#” mark in that
cell.

For example, in case “AGEYR” is now chosen as x-axis variable, the first lines will look like:
B. Select y-axis parameters
To select the parameter for the y-axis:
" Choose which of the parameters in the list should be on the y-axis
" Click on cell in the “Y” column pertaining to that parameter to place the “#” mark in that
cell.
For example, in case “WTOT” (the total dry biomass per ha) is chosen as y-axis variable, the
first lines will look like:

To show the chart in the right pane of the chart screen:
" Click on the
button, or select “Show graph” in the View menu, or click at any location
within the right pane of the chart screen.
The chart will be shown. The y-axis parameter is shown in the legend; the x-axis parameter is
shown with the graph. Note that only one y-axis scaling is used. For example (using the above
choice of x and y-axis parameters):For example (using the above choice of x and y-axis
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parameters):

C. Select additional y-axis parameters
More y-axis parameters can be included in one chart, by selecting other parameters:
" Choose which of the parameters in the list should also be on the y-axis
" Click on cell in the “Y” column pertaining to that parameter to place the “#” mark in that
cell. For example, in case “WPD” (the dry biomass of pods per ha) is chosen as x-axis
variable, the first lines will look like:

Now, update the chart:
" Click on the
button, or select “Show graph” in the View menu, or click at any location
within the right pane of the chart screen.
The updated chart will be shown. The y-axis parameters are shown in the legend; the x-axis
parameter is shown with the graph. For example (using the above choice of x and y-axis
parameters):
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D. De-select y-axis parameters
To de-select a parameter:
" Click on cell in the “-” column pertaining to the selected parameter to place the “#” mark in
that cell.
Now, update the chart:
" Click on the
button, or select “Show graph” in the View menu, or click at any location
within the right pane of the chart screen.
For information on zooming in:
For information on getting output of reruns in charts:
For information on copying a chart as a picture
For general information on the contents of the chart screen

! Section 9.4
! Section 9.3
! Section 9.5
! Section 9.7

9.3 Selecting reruns for a chart
Model output for different reruns can be combined in one chart.
To select model runs
!A
To de-select model runs
!B
A. Select model run
To select model run(s) for which model output should be included in the chart:
" Click on the “Runs” tab in the Chart screen.
The screen that appears contains the following type of information:

The number of runs shown in the screen depends on the number of reruns specified in
reruns.dat (see Section 5.6).
" Select run(s) for which information should be included in the chart by ticking the box(es)
pertaining to the run(s).
For example, if both the default run 0 and rerun 1 should be included:

Now, update the chart:
" Click on the
button, or select “Show graph” in the View menu, or click at any location
within the right pane of the chart screen.
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The updated chart will be shown. The run number is shown in the legend. For example:

B. De-select model run
To de-select model run(s) for which information should not be included in the chart:
" Click on the “Runs” tab in the Chart screen.
For example, if runs 0 and 1 have been ticked:

" Click on the ticked box(es) for the run(s) that should not be included
For example, if run 0 is de-selected:

Now, update the chart:
" Click on the
button, or select “Show graph” in the View menu, or click at any location
within the right pane of the chart screen.
The updated chart will be shown.

9.4 Zooming-in a chart
A part of a chart can be selected to be shown (zoom-in).
To zoom in:
" Place the mouse arrow in one of the corners of the desired part of the chart
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" Hold the Shift key and press the left mouse button while moving the mouse arrow to the
opposite corner of the desired chart part
While moving the mouse you will see a rectangle enclosing the selected part
" Loosen the mouse button to show a new chart of the selected part.
To zoom out to the original chart size:
" Click on the
button, or select “Show graph” in the View menu, or click at any location
within the right pane of the chart screen.

9.5 Copying a chart as a picture
FSEWin charts can be copied as a picture to other programs (e.g. word-processing programs or
presentation software). The chart is first copied to the clipboard. The file format is Enhanced
Metafile.
To copy a chart:
" Click on the
button, or select “Copy” in the Edit menu, or press Ctrl+C.
" Open the program to which you wish to copy.
" Press Ctrl+V or select “Paste” from the Edit menu (which is usually available)

9.6 Closing the chart screen
When you wish to return to the FSEWin main screen, the chart screen should first be closed. To
close the chart screen:
" Click on the
button in the right upper corner of the chart screen, or select “Close” from
the File menu, press Alt+F4

9.7 Contents of the chart screen
9.7.1 Menu’s and icons
File menu
Print:
Close:
Edit menu
Copy:

View menu
Dynamic output:
Initial and
terminal output:

Prints the chart in the right pane of the chart screen to the default printer.
Closes the chart screen and returns to the FSEWin main screen. Note that
charts are not saved
Copies the chart and moves it to the clipboard for later use. (The chart can be
pasted in word processing or presentation software).

This option indicates whether dynamic output (output during model run) of the
model is shown in the chart. This option should always be ticked.
This option indicates whether initial and terminal output (the initial situation and
the situation at the end of the model simulation) of the model is shown in the
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chart. This option should not be ticked. In case this option is ticked no output
parameters will be available for the chart.

9.7.2 The left pane
The left pane of the FSEWin chart screen may be used to select parameters and reruns for
inclusion in the chart. Two tabs are available:
The “Axes” tab is used to select and de-select parameters for inclusion in the chart. Parameters for
the x and y axes of the chart can be selected. The z-axis is not available at this stage. The “Select
none” button is used to de-select all parameters:

The “Runs” tab is used to select and de-select runs (the default run 0 and possible reruns).
For instructions on selecting parameters for charts
For instructions on selected reruns for charts

! Section 9.2
! Section 9.3

9.7.3 The right pane
The right pane of the FSEWin chart screen contains the charts. The parameters included in the
chart are mentioned in the chart legend, the x-axis parameter is shown below the x-axis. Charts can
be updated by clicking on any position within the right pane. A selection of the chart can be shown
by using pressing Shift while selecting the area with the mouse (keeping both the Shift key and the
left mouse button pressed). See Section 9.4 on zooming in a chart.
No changes can be made to the layout of the chart: the colours of lines and markers, the axis
division, font size used and other attributes of the layout are default settings, More complex graphs
should be produced in other packages such as Microsoft Excel using the option to copy data from
tables (see Section 8.2).
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Closing CASE2 and FSEWin

10.1 Closing CASE2
To close the CASE2 model, first save the changes in input files:
" Click on the
button, or select “Save all” in the File menu, or press Ctrl+S
" In the “Open Project” window, select the case2.fpf in the C:\CASE2\program directory and
click on “Open” (or double-click on the case2.fpf file)

10.2 Exiting FSEWin
To exit FSEWin:
" Select “Exit” in the File menu
In case changes in one or more CASE2 files have not been saved, the following screen appears:

" Click on “Yes” to save changes. The FSEWin program will close.
In case all changes in the CASE2 files have been saved, the following screen appears:

" Click on “Yes”
For more information on the FSEWin screen and menu’s:

! Section 4.3
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Trouble shooting and support

11.1 Warnings and errors in the DOS screen
During or prior to the CASE2 model run, warning messages or error messages may appear in the
DOS screen. Warnings and errors are essentially different:
Message
Warning:

What does is imply?
This indicates that the model
is running in an unusual way,
or that a certain parameter
has an unusual value.

Error:

This indicates that the model
cannot be run properly due to
an error at the start or during
the model run.

Example
(1) The maximum tree age is
reached during the
simulation. (2) The tree’s
reserves are depleted due to
low radiation or low rain fall.
The simulation period
specified in basic.dat is
longer than the period for
which weather data is
available.

What happens?
- Model run
continues (usually)
- Output generated

- Model halted
- No output

! Appendix II

For a list of possible warnings and errors:

11.2 Some possible problems in FSEWin
When does the problem occur?
• While running CASE2 but not in the DOS screen?
• When viewing charts

!A
!B

A. Problems while running the CASE2 model before the DOS screen is opened
1. Error message:

This is probably caused by settings of the autoexec.bat file, which was not changed during the
installation of Visual Fortran. To solve the problem:
" Open the C:\autoexec.bat file in a word processing program or the Notepad program
" Make a backup of the file, changing the *.bat to *.bck (for backup)
" Check whether the following lines are included. It is not important that the lines starting
with “rem” contain exactly the same information as in the example; the call to DFVARS.BAT
should be included in any case:
rem - Lines added by Visual Fortran 6.0.A Setup on 5-17-2001
CALL C:\PROGRA~1\MICROS~1\DF98\BIN\DFVARS.BAT AUTOEXEC
rem - End of lines added by Visual Fortran 6.0.A Setup

" If not, add these lines at the end of the file
" Save the file as autoexec.bat, overwriting the old version
" Shut down the computer and start it again.
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2. Compilation failed or linking failed
Changes have probably been made in the fortran source files (fse.for, model2.for or case2.for).
These changes should be undone! In case the problem persists, re-install the CASE2 model.
B. Problems when viewing graphs
3. Do not see entire chart.
This is probably caused by the choice of large letters in the Windows screen setting. To solve
the problem, choose Settings and Configuration window from the Windows Start menu. In the
Configuration window, choose Display properties and within this window, the Settings tab. Either
change the font size from Large font to Small font in this window or do so in the window that is
opened after pressing the “Advanced” button.
4. No chart and message:

This problem is probably caused by an error during the last model run (an error mentioned in the
DOS screen during model run). The message “No variables found” may be displayed as well. No
model output is generated in this case. To solve this problem, the cause of the error during
model run should be solved. (see Appendix II for a list of possible problems and possible
solutions).
5. No chart and message:

This problem is caused by the lack of a database definition in the installation of FSTWin. To
solve the problem:
" Open the Control panel (by selecting “Settings” in the Windows Start menu and then
“Control Panel”)
" Double-click on “BDE Administration”
The following screen appears:

Now, create a new “database”:
" Select “New..” from the Object menu
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" Select “STANDARD” in the “New Database Alias” screen
" Replace the text “STANDARD1” with “FSTdb”
" Type the path “C:\Program Files\FSTWin” for the PATH
The following information should now be in the right pane of the screen:

" Select “Exit” from the Object menu, saving the changes
" Start FSEWin again
6. No chart and message: “Table is full”
This is probably when daily output frequency is selected (OUTPUTFQ=3) and the simulation is
done for a long period of time. Limit the time period of the simulation or select another output
frequency.
7. No chart and message “License information for Tchart2D is invalid”
This is probably due to a problem during the installation of FSTWin. Try to install FSTWin again.
If the problem persists, contact the authors.
8. The chart window does not open; the following message appears in the right pane:
The file C:\case2\program\chart.txt was not found

This is caused by an error during the last model run. When this problem is solved and a new
model run is performed, the chart screen will open, containing the output of the new model run.
9. Other problems.
Please contact the authors at the mail or e-mail address indicated on page 2 of this report.
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Appendix I: List of input and output parameters
This appendix contains tables with input and output parameters of CASE2.

Input parameters
Input parameters are those that are included in the *.dat files (basic.dat, timer.dat, plant.dat and
soil.dat). Note that only part of these parameters may be changed by the user. Standard values for
most of the parameters are included in the prints of *.dat files in Appendix III.
Table I-1. A list of codes, units and descriptions of all input parameters. °C = degrees Celsius; C = carbon;
CH2O = carbohydrates (sugars or assimilates); CO2 = carbo-dioxide; D= day; DW = dry weight; h = hour; ha =
hectare; kg = kilogram; m = meter; y = year.
Input parameters
Code

Unit

Description

AGBIORA

kg DW d

Regression coefficient for age-biomass relation

AGBIORB

kg DW

Regression coefficient for age-biomass relation

AGEIYR

y

Initial cacao tree age

AMINIT

-

Factor accounting for lower photosynthesis in young leaves

-1

AMTMPT

-

AMX

kg CO2 ha leaf h

ASRQLRT

kg CH2O kg DW d

ASRQLV

Table with reduction factor for temperature effects on AMX
-1

-1

-1

Maximum rate of photosynthesis
-1

Assimilate requirement for the production of 1 kg lateral roots

-1

Assimilate requirement for the production of 1 kg leaves

-1

Assimilate requirement for the production of 1 kg taproot

-1

kg CH2O.kg DW

ASRQPDTB

-

ASRQTRT

kg CH2O kg DW

Table of pod assimilate requirements depending on fat content

ASRQWD

kg CH2O kg DW

Assimilate requirement for the production of 1 kg wood

AVGLVAGE

d

Estimated average and minimum leaf age

BHRA

°C

BHRB

-

-1

Butter hardness regression coefficient
Butter hardness regression coefficient
-1

Mass fraction carbon in the fine roots

-1

Mass fraction carbon in the leaves

-1

Mass fraction carbon in the taproot

-1

CFFRT

kg C kg DW

CFLV

kg C.kg DW

CFPDTB

-

CFTRT

kg C kg DW

Table of pod C content depending on fat content

CFWD

kg C kg DW

Mass fraction carbon in the wood

CLFILE

-

File name for weather files with monthly data

CNTR

-

Country code for weather file

COPINF

-

Switch variable what should be done with

DELT

d

Time step of integration

DELTMP

-

DEVRR1A

d °C

Switch variable what should be done with

DEVRR1B

d

DEVRR2A

d °C

DEVRR2B

d

-1

-1

Regression coefficient on relation between temperature and pod
ripening

-1

Regression coefficient on relation between temperature and pod
ripening

-1

-1

Regression coefficient on relation between temperature and pod
ripening

-1

Regression coefficient on relation between temperature and pod
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Input parameters
Code

Unit

Description
ripening

DIAM1

m

Mean diameter of fine roots (diameter < 1 mm)

DIAM2

m

Mean diameter of fine roots ( diameter between 1 and 2 mm)

EES

m

EFF

(kg CO2 ha h )/(J

-1

Evaporation proportionality factor
-1

-2

-1

Initial light use efficiency for individual leaves

-1

m s )
ENDYR1

-

Final year of simulation

ETMOD

-

Evapotranspiration module (standard = Penman)

FATCONTENT -

Fat content of nibs

FBEANS

-

Dry weight fraction of beans in pod

FLRTRA

kg DW lateral roots

Regression coefficient on relation between lateral root and total

-1

FLRTRB

kg DW whole plant

biomass

kg DW lateral root

Regression coefficient on relation between lateral root and total
biomass

FLVRA

-1

kg DW leaf kg DW

Regression coefficient on relation between leaf and total biomass

whole plant
FLVRB

kg DW leaves

Regression coefficient on relation between leaf and total biomass

FMTA

-

Regression coefficient on biomass loss due to fermentation

FMTB

d

FMTDUR

d

FPDRA

-1

Regression coefficient on biomass loss due to fermentation
Duration of the fermentation process
-1

kg DW pod kg DW

Regression coefficient on relation between pod and total biomass

whole plant
FPDRB

kg DW pod

FRPAR

-

FTRTRA

Regression coefficient on relation between pod and total biomass
Fraction of photosynthetically active radiation (PAR)

kg DW taproot kg

-1

Regression coefficient on relation between taproot and total biomass

DW whole plant
FTRTRB

kg DW taproot

FWDRA

kg DW wood kg DW Regression coefficient on relation between wood and total biomass

Regression coefficient on relation between taproot and total biomass

FWDRB

kg DW wood

-1

whole plant
Regression coefficient on relation between wood and total biomass

FWURT

-

Fraction of lateral roots that is able to extract water

HGHL

m

Lower height of cacao tree crowns

HGHT

m

Upper height of cacao tree crowns

HRTWDAGE

d

Age at which softwood is transformed into non-respiring heartwood

IFLAG

-

Indicates where weather error and warnings are stored

IOBSD

-

Lists year-day combinations for which output is requested

IPFORM

-

Format of output file:

IRNDAT1

-

Indicates type of rainfall data

ISTN1

-

Weather station number (only for daily weather data)

IWEATH1

-

Indicates type of weather data used

IYEAR

-

Start year of the simulation
-1

KCONTBN

kg K kg bean DW

K (potassium) content of dry beans

KDFL

-

Extinction coefficient for cacao leaves

KDFT

-

Extinction coefficient for cacao trunk

LOCATION

-

Location number for which simulations are conducted

LRTWURTDR kg dead lateral roots

Loss of coarse lateral roots relative to that of water-uptaking roots
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Input parameters
Code

Unit

Description

-1

kg dead wateruptaking roots
MAINLRT

-1

-1

kg CH2O kg DW d
-1

-1

MAINLV

kg CH2O.kg DW.d

MAINPD

kg CH2O kg DW d

-1

-1

-1

-1

MAINT

kg CH2O.ha .d

MAINTRT

kg CH2O kg DW d

Maintenance respiration coefficient for lateral roots
Maintenance respiration coefficient of leaves
Maintenance respiration coefficient for pods
Maintenance respiration rate of the crop

-1

-1

Maintenance respiration coefficient for taproot

-1

-1

Maintenance respiration coefficient for wood

MAINWD

kg CH2O kg DW d

MAXLAI

m leaves m ground Maximum LAI used in the photosynthesis subroutines

MINCON

kg CH2O kg DW

Minimum concentration of carbohydrate reserves

MINLVAGE

d

Minimum leaf age

2

-2

-1

MOISTC

-

NCONTBN

kg N kg bean DW

N (nitrogen) content of dry beans

Moisture content of dry, fermented beans

NL

-

Number of soil layers

-1

-1

Cacao tree planting density

NPL

trees ha

NRYEARS

y

OUTPUTFQ

-

PCONTBN

kg P kg bean DW

Number of years for which simulation should be conducted
Frequency at which output is generated
-1

P (phosphorus) content of dry beans

PLTMOD

-

PODVALUE

kg DW

Pod index or pod value (number of pods per kg dry beans)

Name of plant module

PRODLEVL

-

Production level: either potential or water-limited

PRSEL

-

Selection of variables to be included in output and table

Q10

-

RTOWURT

d

SHGHL

M

Lower height of shade tree crowns

SHGHT

m

Upper height of shade tree crowns

-1

Factor accounting for increase of maintenance
-1

Turnover rate of water-uptaking roots

SKDFL

-

SLAI

ha leaf ha ground

Extinction coefficient for leaves of shade trees

SLAR1A

ha leaf kg leaf DW

-1

Leaf area index of shade trees

-1

Regression coefficient on leaf area per unit leaf biomass

-1

kg plant DW
-1

Regression coefficient on leaf area per unit leaf biomass

-1

Regression coefficient on leaf area per unit leaf biomass

SLAR1B

ha leaf kg leaf DW

SLAR2A

ha leaf kg leaf DW
-1

kg plant DW
-1

SLAR2B

ha leaf kg leaf DW

Regression coefficient on leaf area per unit leaf biomass

SOILTYPE

-

Soil type to be used in model simulation
-1

Specific root length, root diameter < 1 mm

-1

Specific root length, root diameter between 1-2 mm

SPRTL1

m kg

SPRTL2

m kg

SSTB

-

Table with sink strength values for pod growth

STRTYR

-

Start year of the simulation

STTIME

d

SW

kg m

Start time of the simulation
-3

Specific weight of wood

SWINPUT

-

Switch for initial cacao tree input: either age or biomass

SWIT6

-

Switch for type of initialisation in water balance module

SWIT8

-

Switch for type of equation used in water balance module

SWIT9

-

Switch for type of soil input in water balance module

TAU

d

Time coefficient
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Input parameters
Code

Unit

TFALA

-

Description
Regression coefficient for through fall
-1

TFALB

mm d

Regression coefficient for through fall

TKL1

m

List with thickness of soil layers
-1

TRANSC

mm d

Characteristic potential transpiration rate

TREF

°C

Reference temperature for calculation of maintenance respiration

TYL1

-

Driessen texture classes for layers

VDWURTRA

-

Regression coefficient on vertical distribution of fine roots
-1

VDWURTRB

kg DW ha m

WCWET

cm cm

WDLVDR

3

-2

Regression coefficient on vertical distribution of fine roots

-3

Volumetric water content where water logging begins

kg dead wood kg

-1

Loss of wood relative to that of leaves.

dead leaves
WTOTI

kg DW tree1

WTOTMIN

kg DW tree

WTRDIR1

-

-1

Total initial dry weight of the cacao tree
Total dry weight of the cacao tree at which fruiting starts
Directory in which weather data are stored
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Output parameters
Output parameters are those that are included in the tables or charts. Which of the output
parameters is included in the output depends on the output frequency specified by the user (by the
parameter OUTPUTFQ in basic.dat; see Section 5.3). The table below provides information on the
output frequency value at which each parameter is included in the table or chart output. More
information on the calculation of a number of parameters can be found in Zuidema & Leffelaar
(2002).
To facilitate interpretation of output parameters, the same letters are used for related parameters:
Parameter starting with:
D…
D10…
G…
W…
Y…

indicates (in most cases):
Death rate in biomass (dry weight) of the cacao tree or a plant part
A value for a period of 10 days
Growth rate in biomass (dry weight) of the cacao tree or a plant part
Dry weight of the cacao tree or a plant part
An annual total

Parameter containing:
..BH..
..BN..
..LRT..
..LV..
..PD..
..RAIN..
..RT..
..TRT..
..TRANS..
..WD..
..WURT..

is related to:
Butter hardness of harvested beans
Bean yield
Lateral roots
Leaves
Pods
Rainfall
Roots
Taproot
Evapotranspiration
Wood
Water-uptaking lateral roots (fine roots)

Table I-2. List of codes, units, description of output parameters. The column Output frequency indicates for
which value of the input parameter OUTPUTFQ (specified in the basic.dat file) this parameter is included in the
table and chart output. 1 = annual output; 2 = output every 10 days; 3 = daily output.
Output parameters
Code

Unit

Description

Output
frequency

AGEYR

y
-1

Age of the cacao tree in years

1,2,3

ATRANS

mm d

Total daily actual transpiration rate of the canopy

3

ATWURT

m2 ha

-1

Total area of water-uptaking roots

3

AWURT

m2 ha

-1

Area of water-uptaking roots per soil layer

3

BHYLD

-

Butter hardness of the daily bean production

3

D10GTOT

kg DW ha 10 d

D10HARPD

10 d

D10RAIN

mm 10 d

D10RDD

J m-2 10 d

D10YLDBN

kg DW ha 10 d

D10YLDPD

kg DW ha 10 d

-1

-1

-1
-1
-1

Total biomass growth during 10 days

2

Number of harvested pods during 10 days

2

Amount of rainfall during 10 days

2

Amount of short-wave radiation during 10 days

2

-1

-1

Yield of dry, fermented beans during 10 days

2

-1

-1

Yield of pods during 10 days

2
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Output parameters
Code

Unit

Description

Output
frequency

DLRT

-1

-1

Daily death rate of lateral root biomass

3

-1

-1

Daily death rate of leaves biomass

3

-1

-1

Daily death rate of leaves biomass due to ageing

3

-1

-1

Daily death rate of leaves biomass due to drought

3

Day number since 1 January (day of year)

2,3

-1

-1

Daily death rate of wood biomass

3

kg DW ha d

DLV

kg DW ha d

DLV1

kg DW ha d

DLV2

kg DW ha d

DOY

-

DWD

kg DW ha d

FLRT

-

Fraction of biomass production allocated to lateral roots

3

FLV

-

Fraction of biomass production allocated to leaves

3

FPD

-

Fraction of biomass production allocated to pods

3

FRABS(1)

-

Fraction of total radiation absorbed by cacao trees

3

FTRT

-

Fraction of biomass production allocated to taproot

3

FWD

-

Fraction of biomass production allocated to wood

3

GLRT

kg DW ha d

-1

-1

Daily growth rate of lateral root biomass

3

-1

-1

Daily growth rate of lateral leaf biomass

3

-1

-1

Daily growth rate of lateral pod biomass

3

GLV

kg DW ha d

GPD

kg DW ha d

-1

-1

GPHOT

kg CH2O ha d

GRT

kg DW ha d

Daily total gross CH2O assimilation

3

-1

-1

Daily growth rate of root biomass

3

-1

-1

Daily growth rate of total biomass

3

-1

-1

Daily growth rate of total biomass: growth accounting for lost

3

-1

-1

-1

-1

Daily growth rate of taproot

-1

-1

Daily growth rate of wood

3

Daily number of harvested pods

3

Leaf area index of the cacao trees

2,3

GTOT

kg DW ha d

GTOT1

kg DW ha d

GTOT2

kg DW ha d

GTRT

kg DW ha d

plant parts
Daily growth rate of total biomass: growth leading to net growth

3

of plant parts
GWD

kg DW ha d

HARPODS

d

LAI(1)

ha leaf ha

-1
-1

3

ground
LTRT

m

LTWURT

m ha

Length of taproot

3

Total length of water-uptaking roots

3

MAINT

kg CH2O ha d

PCEW

Daily rate of maintenance respiration

3

-

Factor that accounts for reduced photosynthesis due to water

2,3

-1
-1

-1

stress
-1

Daily potential transpiration rate

3

-1

Daily amount of rainfall

3

PTRANS

mm d

RAIN

mm d

RDD

J m-2 d

TIME

d

-1

TMAV

°C

TRWL

mm d

WBNCUM

kg DW ha

WLRT

Daily short-wave radiation

3

Day during the simulation

1,2,3

Daily average temperature

2,3

Daily actual transpiration rate per soil layer

3

-1

Cumulative weight of harvested dry, fermented beans

1,2,3

kg DW ha

-1

Actual lateral root biomass

1,2,3

WLV

kg DW ha

-1

Actual leaf biomass

1,2,3

WPD

kg DW ha

-1

Actual pod biomass

1,2,3

WPDCUM

kg DW ha

-1

Cumulative weight of harvested pods

1,2,3

WRT

kg DW ha

-1

Actual root biomass

1,2,3

kg DW ha

-1

Actual total biomass

1,2,3

WTOT

-1
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Output parameters
Code

Unit

Description

Output
frequency

WTOTPP

kg DW ha

-1

Actual total biomass per tree

1,2,3

WTRT

kg DW ha

-1

Actual taproot biomass

1,2,3

WTWURT

kg DW ha

-1

Total biomass of water-uptaking roots

3

WWD

kg DW ha

-1

Actual wood biomass

1,2,3

WWURT

kg DW ha

-1

Biomass of water-uptaking roots per soil layer

3

YEAR

-

Calendar year

1,2,3

YGPHOT

kg CH2O ha y

Annual total gross CH2O assimilation

1

YGTOT

kg DW ha y

Annual total biomass production

1

-1

-1

-1

-1

-1

YHARPD

y

Annual number of harvested pods

1

YHI

-

Annual harvest index (more info in Zuidema & Leffelaar, 2002

1

YHINCR

-

Annual harvest increment (more info in Zuidema & Leffelaar,

1

2002)
YKLOSS

-1

-1

kg ha y

Annual loss of K (potassium) from harvested beans

1

-1

-1

Daily yield of dry, fermented beans

3

-1

-1

Daily yield of pods

3

-1

-1

YLDBN

kg DW ha d

YLDPD

kg DW ha d

YLVD

kg DW ha y

Annual production of dead leaf biomass

1

YMNBH

-

Mean annual butter hardness

1

YMNIPOD

d

YMNLAI

ha leaf ha

-1

Mean annual pod ripening period

1

Mean annual number of leaf area index (LAI)

1

ground
YNLOSS

-1

-1

Annual loss of N (nitrogen) from harvested beans

1

-1

-1

Annual loss of P (phosphorus) from harvested beans

1

Annual rainfall

1

kg ha y

YPLOSS

kg ha y

YRAIN

mm y

-1
-1

YRDD

MJ m-2 y

YRDEFF

kg DW ha
m-2)

YRNEFF

Annual short-wave radiation

1

-1

(MJ

Radiation "efficiency" of bean production

1

-1

mm

Rain "efficiency" of bean production

1

-1

kg DW ha
-1

Annual amount of actual transpiration

1

-1

-1

Annual production of dead wood biomass

1

-1

-1

Annual yield of dry, fermented beans

1

-1

-1

Annual yield of pods

1

YTRANS

mm y

YWDD

kg DW ha y

YYLDBN

kg DW ha y

YYLDPD

kg DW ha y
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Appendix II: Error and warning messages
This appendix contains lists of error and warning messages that may appear in the DOS screen
while running CASE2. For information on the differences between errors and warnings see Section
11.1. Part of the warning and error message are numbered (only those from the CASE2
subroutines).

Error messages
Error messages always contain the following text: “ERROR in <Subroutine>: <Error message>”, in
which <Subroutine> is the name of the subroutine (source code file) in which the error occurred and
<Error message> is the error message itself. For example:
ERROR in CASE2: FE6 - LAI of shade trees too high: >3. ha ha-1.
Press <Enter>
Table II-1. List of error messages displayed in the DOS screen while running CASE2 together with possible
solutions for the problems. When the possible solution is “Contact authors” , the warning message text
together with all *.dat files can be sent by e-mail to the author’s e-mail address mentioned at page 2 of the
report.
Error messages
Subroutine

Error message text

Possible solution

CASE2

FE1 - Time step (DELT) too small: <1 day

Change DELT back to 1 in timer.dat

CASE2

FE2 - Total thickness of soil layers too low:

Increase thickness of soil layers in soil.dat

<1.5 m
CASE2

FE3 - Planting density too low: < 700 ha-1

Increase planting density (NPL) in basic.dat

CASE2

FE4 - Planting density too high: > 2500 ha-1

Decrease planting density (NPL) in basic.dat

CASE2

FE5 - Extinction coefficient of shade trees too

Increase extinction coefficient for shade trees in

low

basic.dat

CASE2
CASE2

FE6 - LAI of shade trees too high: >3. ha ha-1 Decrease LAI for shade trees in basic.dat
FE7 - Shade tree height too high: should be

Decrease height for shade trees in basic.dat

<40 m
CASE2

FE8 - Upper shade tree height <= lower height Decrease lower height or increase upper height
for shade trees in basic.dat

CASE2

FE9 - Cacao tree height too high: should be

Decrease height for cacao trees in basic.dat

<20 m
CASE2

FE10 - Upper cacao tree height <= lower

Decrease lower height or increase upper height

height

for cacao trees in basic.dat

CASE2

FE11 - Initial tree biomass too low: < 18.5 kg

Specify higher initial biomass in basic.dat

CASE2

FE12 - Initial tree biomass too high: > 70.0 kg

Specify lower initial biomass in basic.dat

CASE2

FE13 - Initial tree age too low: < 3 y

Specify higher tree age in basic.dat

CASE2

FE14 - Initial tree age too high: > 39 y

Specify lower tree age in basic.dat

CASE2

FE16 - Av. greater than 40 C.

Do simulations for other location: this location is

CASE2

FE17 - Minimum temperature below 10 C.

CASE2

FE18 - Actual allometry is wrong: sum of

not suitable due to extremely high temperatures
Do simulations for other location: this location is
not suitable due to extremely low temperatures
proportions (CHKPART1) does not equal 1

Contact authors
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Error messages
Subroutine

Error message text

Possible solution

CASE2

FE19 - The ideal biomass fraction of one or

Contact authors

more organs is below 0
CASE2
CASE2

FE20 - Partitioning is wrong,

Contact authors

FE21 - Carbon balance is wrong total

Contact authors

partitioning (CHKPART2) is not equal to 1
CASE2

FE22 - Carbon balance is wrong for one organ, Contact authors
CHK** larger than 0.001

CASE2

FE23 - Maximum leaf age greater than one

Change leaf age to less than 1 yr in plant.dat

year
CASE2

FE24 - Minimum leaf age less than zero (0)

Change leaf age to more than 0 days in plant.dat

CASE2

FE25 - Maximum leaf age less than minimum

Increase maximum leaf age or decrease

leaf age

minimum leaf age in plant.dat

CASE2

FE26 - Too many layers in external arrays

Change number of soil layers to less than 11
(and preferably not more than 6)

CLIMRD

cannot find requested year

Compare start year and duration of simulation (in
basic.dat) with start and end year of weather
data (in timer.dat)

CLIMRD

error while reading climate data

Check whether weather file is opened in another

CLIMRD

illegal rainfall option

Change the value of IRNDAT.. to 0,1 or 2

program; or check the format of the weather file
DRSAHE

delt too large

Change DELT back to 1 in timer.dat

DRSAHE

error in water balance

Contact authors

DRSAHE

evaporation rate greater than zero

Contact authors

DRSAHE

Illegal SWIT8 value

Change SWIT8 value back to 1 in soil.dat

DRSAHE

No information for this SOILTYPE in soil.dat

Change soil type in basic.dat to a value for which
data have been specified in soil.dat

DRSAHE

number of irrigation data is not multiple of three Contact authors

DRSAHE

SWIT6 wrong value ; should be 1, 2 or 3

Change SWIT6 value back to 1 in soil.dat

DRSAHE

SWIT8 wrong value ; should be 1 or 2

Change SWIT8 value back to 1 in soil.dat

DRSAHE

SWIT9 wrong value ; should be 1 or 2

Change SWIT9 value back to 2 in soil.dat

DRSAHE

too few layers in external arrays

Contact authors

DRSAHE

too many layers defined in data file

Reduce number of layers to less than 11
(preferably not more than 6)

DRSAHE

water content greater than field capacity

Contact authors

DRSAHE

water content less than air dry

Contact authors

DRSAHE

wrong ITASK

Contact authors

FSE

Simulation period exceeds period for which

Select an earlier start year (IYEAR) or a shorter

weather data are available: select an earlier

period (NRYEARS) in BASIC.dat

start year (IYEAR) or a shorter period
(NRYEARS) in BASIC.dat
FSE

LOCATION number too high, should not

Change location to a value <24 in basic.dat

exceed 23
FSE

No weather data available for start year

Specify a later start year (IYEAR) in basic.dat

specified in BASIC.dat choose later start year
(IYEAR)
FSE

No weather data available for start year

Specify an earlier start year (IYEAR) in basic.dat
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Error messages
Subroutine

Error message text

Possible solution

specified in BASIC.dat choose earlier start
year (IYEAR)
FSE

Output frequency value (OUTPUTFQ) is invalid Change output frequency (OUPUTFQ) to 1, 2 or

LEAFPA

Negative X or canopy height

Contact authors

LEAFRE

Negative X or canopy height

Contact authors

METEO

current weather option not supported

Contact authors

METEO

DBMETEO option not supported

Contact authors

MODELS

unknown module name for evapotranspiration Restore original timer.dat file

3

MODELS

unknown module name for plant

Restore original timer.dat file

MODELS

Wrong value for PRODLEVL

Specify PRODLEVL in

RANDOM

illegal random set

Contact authors

RANDOM

set not initialised

Contact authors

RANDOM

wrong ITASK

Contact authors

RNDIS

number of rainy days too large

Check number of rain days in weather file,
should not > 30

RNREAL

error in day numbers on file

Contact authors

RNREAL

rain year not found

Check data availability in weather file

SASTRO

LAT > 90 or LAT < -90

Check latitude values in weather file

SETPMD

illegal longwave radiation option

Contact authors

SETPMD

Undefined iteration

Contact authors

SETPMD

unimplemented surface value

Contact authors

SSKYC

total shortwave irradiation <= zero

Check radiation values in weather file

SWSE

WCWET < WCCR

Contact authors
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Warning messages
Warning messages always contain the following text: “WARNING from <Subroutine>: <Warning
message>”, in which <Subroutine> is the name of the subroutine (source code file) in which the
warning is issued and <Warning message> is the warning message itself. For example:
WARNING from CASE2: WA3 - Reserves depleted
Press <Enter>
Table II-2. List of warning messages displayed in the DOS screen while running CASE2 together with possible
solutions for the problems. When the possible solution is “Contact authors” , the warning message text
together with all *.dat files can be sent to the author’s e-mail address mentioned at page 2 of the report.
Warning message
Subroutine

Warning message text

Cause and possible solution

CASE2

WA1 – Very low annual rainfall, < 1000 mm

A year with very low rainfall

CASE2

WA2 – Maximum tree age (40 yr) is reached

CASE2

WA3 – Maximum tree size (70 kg DW) is reached

see above

CASE2

WA4 – Reserves depleted

The model tree’s reserves have

occurred. No solution required.
No solution. This is a model
constraint.

probably been depleted due to lack
of water availability. This may be
due to a combination of low rainfall
and poor water retention in the soil.
Possible solution: try with
favourable soil (e.g. Soil type 1)
CASE2

WA5 - Sum leaf class weights not equal to total leaf weight Contact authors

CASE2

WA6 - Sum leaf class weights not equal to total lf weight

CASE2

WA7 - Sum pod class growth not equal to total pod growth Contact authors

CASE2

WA8 - Sum pod class weight not equal to total pod weight

Contact authors

initial soil moisture in hydrostatic equilibrium not

This implies that water availability in

implemented. Instead, field capacity is used.

the soil is optimal at the start of the

DRSAHE

Contact authors

model run. No solution required. Of
importance for the interpretation of
model output of the first days.
DRSAHE

initial soil moisture content larger than field capacity

Contact authors

DRSAHE

initial soil moisture content less than air dry

Contact authors

DRSAHE

potential soil evaporation has negative sign ! To extract

Contact authors

water from the soil, the sign should be positive.
DRSAHE

rainfall has negative sign ! To add water to the soil through Contact authors
rainfall, the sign should be positive.

DRSAHE

transpiration has negative sign ! To extract water from the Contact authors
soil, the sign should be positive.

DRSAHE

Transpiration extracted water below wilting point in layer

Water content in one of the soil
layers has been very low.

FSE 2.1m

There have been errors and/or warnings from the weather

Check the errors. Change weather

system, check file WEATHER.LOG

data file if necessary

MTYPE

Warning in WEATHR: estimated

No solution required

MTYPE

Warning in WEATHR: estimated and interpolated

No solution required

MTYPE

Warning in WEATHR: interpolated

No solution required
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Warning message
Subroutine

Warning message text

Cause and possible solution

SASTRO

latitude above polar circle, daylength=0 hours

Check latitude in weather data file.

SASTRO

latitude within polar circle, daylength=24 hours

Check latitude in weather data file.

SETPMD

Low short-wave radiation ** J/m2/d

Check short-wave radiation in

SETPMD

Vapour pressure more than 40% greater than saturated !

SSKYC

ATMTR = ** , value very large

SVPS1

Extreme temperature: ** d. Celsius

weather data file
Check vapour pressure values. No
solution required.
Atmospheric transmission very high.
Contact authors
Check weather files for extreme
temperatures (>50 or < -20 °C
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Appendix III: Complete listing of input files
Below the contents of the basic.dat, soil.dat, timer.dat and reruns.dat files is shown as they are
included on the CD-ROM.

BASIC.DAT
************************************************************************
* File name: BASIC.DAT
*
*
*
* Use
: With CASE2 (Cacao Simulation Engine), version 2.2
*
* Author(s): Pieter Zuidema
*
* Date
: January 2002
*
* Purpose : Contains values of input parameters that can be changed. *
*
For instance, location, and planting density
*
************************************************************************
!======================================================================!
!
!
! PART A. Specify information on location, simulation duration,
!
!
soil type, production level and output frequency here.
!
!
!
!======================================================================!
!---------------------------------!
! Location
!
!---------------------------------!
*
*
*
*
*

Specify location number
Possible values:
1-50 for daily or monthly weather data (1-18 are included with program)
>50 for long-term weather data (51-69 are included with program)
For location numbers see the table at the end of this file or in the Manual.
LOCATION = 15

!---------------------------------!
! Start and duration of simulation!
!---------------------------------!
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*

Specify the start year of the simulation (IYEAR) and the number of
years for which simulations should be carried out.
Possible values for IYEAR:
for daily/monthly weather data:
Years for which weather data are available. Check the availability
of weather data for the location in Table 5.1 in the User's or the
table at the end of this file.
for long-term weather data:
enter the value 1000
Possible values for NRYEARS:
for daily/monthly weather data:
This depends on the period of years for which weather data are
available. Check this in Table 5.1 in the User's or the table at
the end of this file.
for long-term weather data:
any period of years
IYEAR
= 1980
NRYEARS = 10
! [y]

!---------------------------------!
! Output frequency
!
!---------------------------------!
* Specify the frequency at which output is generated in table and graph format.
* Choose 1 for annual output; 2 for output every 10 days
* and 3 for daily output
OUTPUTFQ = 1
!---------------------------------!
! Soil type
!
!---------------------------------!
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* Specify the soil type.
* Possible values: 1-3 for soil types included with the program
* (1=Loamy soil,2=Sandy soil, 3=Clayey soil); >3 for user-defined soils
SOILTYPE = 1
!---------------------------------!
! Potential or water-limited
!
!---------------------------------!
* Specify whether simulations should be carried out for a potential or waterlimited
* situation.
* Possible values: 1=Potential; 2=Water-limited
PRODLEVL = 2

!======================================================================!
!
!
! PART B. Specify cropping system characteristics here
!
!
(planting density, cacao tree age and shade tree information)!
!
!
!======================================================================!
!---------------------------------!
! Cropping system
!
!---------------------------------!
* Specify density at which cacao trees are planted in trees per ha.
* Possible values: 700.-2500. Note that number should be followed
* by a period sign (e.g. "1000.").
NPL
= 1000.
! [trees ha-1]
* Specify leaf area index (LAI) of shade trees in ha leaf per ha ground.
* Possible values: 0.-3. Note that number should include
* a period sign (e.g. "1." or "0.2").
SLAI = 0.2
! [ha leaf ha-1 ground]
* Specify extinction coefficient for shade trees.
* Possible values: 0.4 - 0.8.
SKDFL = 0.6
! [-]
*
*
*
*
*

Specify height of the shade tree canopy in m. SHGHL for height of lower
canopy boundary; SHGHT for height of upper canopy boundary
Possible values: 0.-40. Note that number should include
a period sign (e.g. "5." or "7.5").
Note that SHGHL should be less than SHGHT
SHGHL = 4.0
! [m] Lower height of shade tree crowns
SHGHT = 10.
! [m] Upper height of shade tree crowns

!---------------------------------!
! Cacao tree
!
!---------------------------------!
*
*
*
*
*

Specify height of the cacao tree in m: HGHL for height of lower canopy
boundary; HGHT for height of upper canopy boundary
Possible values: 0.-20. Note that number should include
a period sign (e.g. "1." or "2.5").
Note that HGHL should be less than HGHT
HGHL = 0.75
![m]
HGHT = 3.50
![m]

*
*
*
*

Specify whether tree size or age is used for initial input
Both plant size (biomass) and plant age can be used as input.
The switch parameter SWINPUT determines which of the two is used.
Possible values: 1=age is used as input; 2=size is used as input.
SWINPUT = 1
![-]

*
*
*
*

Specify initial tree age in years.
Note: this value is only used in case SWINPUT = 1
Possible values: 3. - 40. Note that number should include
a period sign (e.g. "5." or "12.5").
AGEIYR = 4.11
! [y]

* Specify initial tree size (biomass per tree).
* Note: this value is only used in case SWINPUT = 2
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* Possible values: 18.5 - 70.0. Note that number should include
* a period sign (e.g. "20." or "22.5").
WTOTI
= 18.5
![kg DW tree-1]; NOTE: Minimum size=18.5 kg
!------------------------------------!
! Pod characteristics and processing !
!------------------------------------!
* Specify the fat content of nibs
* The standard value is 0.55 (Wood and Lass 1986)
FATCONTENT = 0.55
![-]
* Specify the fraction of beans per pod
* The standard value is 0.55
FBEANS = 0.55

![-]

* Specify the pod index or pod value
* This is the number of pods needed for one kg of dry beans
* The standard value is 30.
PODVALUE = 30.
![kg-1 DW]
* Specify the fermentation duration in hours.
* The standard value is 5.(Humphries, 1944)
FMTDUR
= 5.
![d]
* Specify the moisture content of the beans
* The standard value is 0.075 (Wood & Lass 1985)
MOISTC = 0.075
![-]

!======================================================================!
! TABLE WITH LOCATION NUMBERS AND PERIODS WITH AVAILABLE WEATHER DATA !
!======================================================================!
!----------------------------------------------------------------------!
! A.DAILY AND MONTHLY WEATHER DATA
!
!----------------------------------------------------------------------!
!LOCATION
Country
Site
Start Yr End Yr Period!
! 1
Brazil
Maceio (Alagoas)
1961
1969
8 !
! 2
Costa Rica
El Carmen
1974
1991 18 !
! 3
Costa Rica
La Lola
1973
1990 18 !
! 4
Costa Rica
La Mola
1980
1989 10 !
! 5
Costa Rica
Puerto Limon
1970
1990 21 !
! 6
Ghana
Tafo
1963
1997 35 !
! 7
Indonesia
Bah Lias
1979
1993 15 !
! 8
Ivory Coast
Abidjan
1987
1996 10 !
! 9
Ivory Coast
Adiake
1987
1995
9 !
! 10
Ivory Coast
Daloa
1987
1996 10 !
! 11
Ivory Coast
Dimbokro
1987
1996 10 !
! 12
Ivory Coast
Gagnoa
1986
1997 12 !
! 13
Ivory Coast
Man
1987
1996 10 !
! 14
Ivory Coast
San Pedro
1987
1996 10 !
! 15
Malaysia
Tawau (Sabah)
1951
1993 43 !
! 16
Malaysia
Telok Chengai
1978
1988 11 !
! 17
Papua New Guinea
Dami
1970
1991 22 !
! 18
Philippines
IRRI wet station site 1979
1995 17 !
! 19
- user-defined !
! 20
- user-defined !
! 21
- user-defined !
! 22
- user-defined !
! 23
- user-defined !
! etc.
!
!----------------------------------------------------------------------!
!----------------------------------------------------------------------!
! B.LONG-TERM WEATHER DATA
!
!----------------------------------------------------------------------!
!LOCATION
Country
Site
!
! 51
Brazil
Belem
!
! 52
Brazil
Salvador
!
! 53
Brazil
Vitoria
!
! 54
Cameroon
Batouri
!
! 55
Cameroon
Douala
!
! 56
Colombia
Andagoya
!
! 57
Colombia
Villavicencio
!
! 58
Ghana
Hon
!

III-4

Appendix III: Listing of input files
! 59
Ghana
Kumasi
!
! 60
Ghana
Tafo
!
! 61
Ivory Coast
Abidjan
!
! 62
Ivory Coast
Gagnoa
!
! 63
Ivory Coast
Man
!
! 64
Malaysia
Kuala Trengganu
!
! 65
Malaysia
Penang
!
! 66
Malaysia
Sandakan
!
! 67
Malaysia
Tawau
!
! 68
Papua New Guinea
Madang
!
! 69
Papua New Guinea
Rabaul
!
! 70
- user-defined !
! 71
- user-defined !
! 72
- user-defined !
! 73
- user-defined !
! 74
- user-defined !
! etc.
!
!----------------------------------------------------------------------!
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RERUNS.DAT
************************************************************************
* File name: RERUNS.DAT
*
*
*
* Use
: With CASE2 (Cacao Simulation Engine), version 2.2
*
* Purpose : Contains values of input parameters that can be changed. *
*
For instance, location, and planting density
*
************************************************************************
!======================================================================!
!
!
! PART A. EXAMPLE RERUNS
!
!
To use one of the example reruns, simply remove the "*"-sign !
!
at the start of the line. Do not forget to place an "*" again!
!
when you do not wish to do reruns for that parameter.
!
!======================================================================!
!---------------------------------!
! Production level
!
!---------------------------------!
*When removing the * in the below line, an extra run will be performed
*for PRODLEVL = 1 (potential production).
*PRODLEVL = 1
!---------------------------------!
! Soil type
!
!---------------------------------!
*When removing the * in the below lines, 2 extra runs will be performed
*for SOILTYPE = 2 and 3 (sandy and clayey soils).
* SOILTYPE = 2
* SOILTYPE = 3
!---------------------------------!
! Shade level
!
!---------------------------------!
*When removing the * in the below lines, 7 extra runs will be performed
*for LAI of the shade tree SLAI = 0 ... 3 (no shading to heavy shading).
*SLAI = 0.
*SLAI = 0.5
*SLAI = 1.
*SLAI = 1.5
*SLAI = 2.
*SLAI = 2.5
*SLAI = 3.
!======================================================================!
!
!
! PART B. USER-DEFINED RERUNS
!
!
To add a user-defined rerun, simply write one line of the
!
!
type:
<PARNAME> = <VALUE>
!
!
in which <PARNAME> is the name of an input parameter and
!
!
<VALUE> is the value for which a rerun is wanted.
!
!
To de-select the rerun, simply put an "*" mark in front of
!
!
the line. More instructions in the User's manual
!
!
!
!======================================================================!
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SOIL.DAT
************************************************************************
* SOIL.DAT
*
*
*
* To be used with CASE2 (CAcao Simulation Engine), version 2.2
*
* This data
file contains soil information used by CASE2
*
*
************************************************************************
************************************************************************
* INFORMATION IN PART A OF THIS THIS DATA FILE MAY BE CHANGED
*
************************************************************************
!======================================================================!
!
!
! PART A. Information may be added to this part of the file.
!
!
Please follow the instructions in the User's Manual
!
!
!
!======================================================================!
!---------------------------------!
! Soil type specifications
!
!---------------------------------!
* Soil type 1
* Loamy soil with 4 layers, soil characteristics from Wessel (1971)
* Nigeria
NL1
= 4
! Number of layers
TKL1
= 0.10,0.30, 0.30, 1.50
! Thickness of layers (m)
TYL1
= 12., 9., 8., 8.
! Driessen texture classes for layers
! See table in User's Manual or below
* Soil type 2
* Sandy soil taken from Wood & Lass(1985), Table 3.8
* Brazil, Rondonia
NL2
= 4
! Number of layers
TKL2
= 0.09,0.14, 0.12, 1.19
! Thickness of layers (m)
TYL2
= 1., 7., 9., 14.
! Driessen texture classes for layers
! See table in User's Manual or below
* Soil type 3
* Clayey soil taken from Wood & Lass(1985), Table 3.17
* Malaysia, Tawau
NL3
= 4
! Number of layers
TKL3
= 0.02,0.54, 0.48, 0.52
! Thickness of layers (m)
TYL3
= 12., 17., 19., 19.
! Driessen texture classes for layers
! See table in User's Manual or below
* Soil type 4
* < specify type of soil and information source here >
* < specify country and area here >
NL4
= 0
! Number of layers
TKL4
= 0., 0., 0., 0.
! Thickness of layers (m)
TYL4
= 0., 0., 0., 0.
! Driessen texture classes for layers
! See table in User's Manual or below
* Soil type 5
* < specify type of soil and information source here >
* < specify country and area here >
NL5
= 0
! Number of layers
TKL5
= 0., 0., 0., 0.
! Thickness of layers (m)
TYL5
= 0., 0., 0., 0.
! Driessen texture classes for layers
! See table in User's Manual or below
* Soil type 6
* < specify type of soil and information source here >
* < specify country and area here >
NL6
= 0
! Number of layers
TKL6
= 0., 0., 0., 0.
! Thickness of layers (m)
TYL6
= 0., 0., 0., 0.
! Driessen texture classes for layers
* Soil type 7
* < specify type of soil and information source here >
* < specify country and area here >
NL7
= 0
! Number of layers
TKL7
= 0., 0., 0., 0.
! Thickness of layers (m)

.

*
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TYL7

= 0., 0., 0., 0.
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! Driessen texture classes for layers

* Soil type 8
* < specify type of soil and information source here >
* < specify country and area here >
NL8
= 0
! Number of layers
TKL8
= 0., 0., 0., 0.
! Thickness of layers (m)
TYL8
= 0., 0., 0., 0.
! Driessen texture classes for layers

!======================================================================!
!
!
! PART B. NO changes may be made to this part of the data file.
!
!
!
!======================================================================!
* Evaporation proportionality factor
EES = 20.
! m-1
* Type of equation used
SWIT8 = 1

* Type of soil input
SWIT9 = 2
* Initialization
SWIT6 = 1

! (1) Driessen equation
! (2) van Genuchten equation
! (3) Linear interpolation

! Use predefined texture classes

! (1) Initial water content field capacity
! (2) Initial water content user defined
! (3) Initial water content wilting point

!======================================================================!
! TABLE WITH RIJTEMA/DRIESSEN SOIL TEXTURE TYPES (Driessen, 1986)
!
!======================================================================!
!----------------------------------------------------------------------!
!
TYL Description
TYL Description
!
!
!
!
1. Coarse sand
11. Fine sandy loam
!
!
2. Medium coarse sand (mcs)
12. Silt loam
!
!
3. Medium fine sand
13. Loam
!
!
4. Fine sand
14. Sandy clay loam
!
!
5. Humous loamy mcs
15. Silty clay loam
!
!
6. Light loamy mcs
16. Clay loam
!
!
7. Loamy mcs
17. Light clay
!
!
8. loamy fine sand
18. Silty clay
!
!
9. Sandy loam
19. Heavy clay
!
!
10. Loess loam
20. Peat
!
!----------------------------------------------------------------------!
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TIMER.DAT
************************************************************************
* TIMER.DAT
*
*
*
* To be used with CASE2 (CAcao Simulation Engine), version 2.2
*
* This data file contains timer and weather information used by CASE2 *
*
*
************************************************************************
************************************************************************
* INFORMATION IN PART A OF THIS THIS DATA FILE MAY BE CHANGED
*
************************************************************************
!======================================================================!
!
!
! PART A. Location specifications.
!
!
Information may be added to this part of the file.
!
!
Please follow the instructions in the User's Manual
!
!
!
!======================================================================!
!----------------------------------------------------------------------!
! Explanation of parameters:
! WTRDIR = Directory of weather data
! CLFILE = File with weather data when IWEATH = 0,1 (WOFOST or
!
longterm weather data)
! IWEATH = Flag indicating the weather system used:
!
Possible values: 0,1 for Wofost monthly weather;
!
2 for Cabo daily weather
! CNTR
= Country of weather data; only to be used in combination
!
with Cabo daily weather (IWEATH = 2)
! ISTN
= Station number of weather data; only to be used
!
in combination with Cabo daily weather (IWEATH = 2)
! IRNDAT = Flag indicating rainfall system when IWEATH = 0, 1:
!
Possible values: 0 for generated rain,
!
1 for distributed rain, 2 for observed rain.
! STRTYR1 = First year for which weather data are available
! ENDYR1 = Last year for which weather data are available
!----------------------------------------------------------------------!
!---------------------------------!
! Daily or monthly weather data
!
!---------------------------------!
* LOCATION 1
* Brazil, Maceio (Alagoas) 1961 1969 d
WTRDIR1 = 'c:\case2\weather\daily\'
CNTR1
= 'brazil'
ISTN1
= 2
IWEATH1 = 2
IRNDAT1 = 2
STRTYR1 = 1961
ENDYR1 = 1969
* LOCATION 2
* Costa Rica El Carmen
1974 1991 d
WTRDIR2 = 'c:\case2\weather\daily\'
CNTR2
= 'cr'
ISTN2
= 1
IWEATH2 = 2
IRNDAT2 = 2
STRTYR2 = 1974
ENDYR2 = 1991
* LOCATION 3
* Costa Rica
La Lola
1973
WTRDIR3 = 'c:\case2\weather\daily\'
CNTR3
= 'cr'
ISTN3
= 4
IWEATH3 = 2
IRNDAT3 = 2
STRTYR3 = 1973
ENDYR3 = 1990
* LOCATION 4
* Costa Rica

La Mola

1980

1990

18

d

1989

10

d
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WTRDIR4
CNTR4
ISTN4
IWEATH4
IRNDAT4
STRTYR4
ENDYR4

=
=
=
=
=
=
=
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'c:\case2\weather\daily\'
'cr'
6
2
2
1980
1989

* LOCATION 5
* Costa Rica, Puerto Limon 1970
1990
WTRDIR5 = 'c:\case2\weather\daily\'
CNTR5
= 'cr'
ISTN5
= 5
IWEATH5 = 2
IRNDAT5 = 2
STRTYR5 = 1970
ENDYR5 = 1990
* LOCATION 6
* Ghana
Tafo
1963 1997
35
WTRDIR6 = 'c:\case2\weather\monthly\'
CLFILE6 = 'ghataf.wof'
IWEATH6 = 1
IRNDAT6 = 1
STRTYR6 = 1963
ENDYR6 = 1997
* LOCATION 7
* Indonesia
Bah Lias
1979
WTRDIR7 = 'c:\case2\weather\monthly\'
CLFILE7 = 'idnbhl.wof'
IWEATH7 = 1
IRNDAT7 = 1
STRTYR7 = 1979
ENDYR7 = 1993
* LOCATION 8
* Ivory Coast
Abidjan
1987
WTRDIR8 = 'c:\case2\weather\monthly\'
CLFILE8 = 'civabi.wof'
IWEATH8 = 1
IRNDAT8 = 1
STRTYR8 = 1987
ENDYR8 = 1996
* LOCATION 9
* Ivory Coast
Adiake
1987
WTRDIR9 = 'c:\case2\weather\monthly\'
CLFILE9 = 'civadi.wof'
IWEATH9 = 1
IRNDAT9 = 1
STRTYR9 = 1987
ENDYR9 = 1995
* LOCATION 10
* Ivory Coast
Daloa
1987
1996
WTRDIR10 = 'c:\case2\weather\monthly\'
CLFILE10 = 'civdal.wof'
IWEATH10 = 1
IRNDAT10 = 1
STRTYR10 = 1987
ENDYR10 = 1996
* LOCATION 11
* Ivory Coast
Dimbokro 1987
1996
WTRDIR11 = 'c:\case2\weather\monthly\'
CLFILE11 = 'civdim.wof'
IWEATH11 = 1
IRNDAT11 = 1
STRTYR11 = 1987
ENDYR11 = 1996
* LOCATION 12
* Ivory Coast
Gagnoa
1986
WTRDIR12 = 'c:\case2\weather\monthly\'
CLFILE12 = 'civgag.wof'

21

d

m

1993

15

m

1996

10

m

1995

9

m

10

m

10

m

1997

12

m
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IWEATH12
IRNDAT12
STRTYR12
ENDYR12

=
=
=
=

1
1
1986
1997

* LOCATION 13
* Ivory Coast
Man
1987
WTRDIR13 = 'c:\case2\weather\monthly\'
CLFILE13 = 'civman.wof'
IWEATH13 = 1
IRNDAT13 = 1
STRTYR13 = 1987
ENDYR13 = 1996
* LOCATION 14
* Ivory Coast
San Pedro
1987
WTRDIR14 = 'c:\case2\weather\monthly\'
CLFILE14 = 'civsan.wof'
IWEATH14 = 1
IRNDAT14 = 1
STRTYR14 = 1987
ENDYR14 = 1996
* LOCATION 15
* Malaysia Tawau (Sabah)
1951
1993
WTRDIR15 = 'c:\case2\weather\monthly\'
CLFILE15 = 'mystab.wof'
IWEATH15 = 1
IRNDAT15 = 1
STRTYR15 = 1951
ENDYR15 = 1993
* LOCATION 16
* Malaysia Telok Chengai1978 1988
11
WTRDIR16 = 'c:\case2\weather\monthly\'
CLFILE16 = 'mals002a.wof'
IWEATH16 = 1
IRNDAT16 = 1
STRTYR16 = 1978
ENDYR16 = 1988
* LOCATION 17
* Papua New Guinea Dami 1970
1991
WTRDIR17 = 'c:\case2\weather\daily\'
CNTR17
= 'png'
ISTN17
= 1
IWEATH17 = 2
IRNDAT17 = 2
STRTYR17 = 1970
ENDYR17 = 1991
* LOCATION 18
* Philippines
IRRI
1979 1995
WTRDIR18 = 'c:\case2\weather\daily\'
CNTR18
= 'phil'
ISTN18
= 1
IWEATH18 = 2
IRNDAT18 = 2
STRTYR18 = 1979
ENDYR18 = 1995

1996

10

m

1996

10

m

43

m

m

22

d

17

d

* LOCATION 19
* < specify location name and period of weather data here >
WTRDIR19 = ' '
CNTR19
= ' '
CLFILE19 = ' '
ISTN19
= 0
IWEATH19 = 0
IRNDAT19 = 0
STRTYR19 = 0
ENDYR19 = 0
* LOCATION 20
* < specify location name and period of weather data here >
WTRDIR20 = ' '
CNTR20
= ' '
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CLFILE20
ISTN20
IWEATH20
IRNDAT20
STRTYR20
ENDYR20

=
=
=
=
=
=

' '
0
0
0
0
0

* LOCATION 21
* < specify location name and period of weather data here >
WTRDIR21 = ' '
CNTR21
= ' '
CLFILE21 = ' '
ISTN21
= 0
IWEATH21 = 0
IRNDAT21 = 0
STRTYR21 = 0
ENDYR21 = 0
* LOCATION 22
* < specify location name and period of weather data here >
WTRDIR22 = ' '
CNTR22
= ' '
CLFILE22 = ' '
ISTN22
= 0
IWEATH22 = 0
IRNDAT22 = 0
STRTYR22 = 0
ENDYR22 = 0
* LOCATION 23
* < specify location name and period of weather data here >
WTRDIR23 = ' '
CNTR23
= ' '
CLFILE23 = ' '
ISTN23
= 0
IWEATH23 = 0
IRNDAT23 = 0
STRTYR23 = 0
ENDYR23 = 0
!---------------------------------!
! Long-term weather data
!
!---------------------------------!
* LOCATION 51
* Brazil
Belem
CLFILE51 = 'Bra9.ltm'
* LOCATION 52
* Brazil
Salvador
CLFILE52 = 'Bra99.ltm'
* LOCATION 53
* Brazil
Vitoria
CLFILE53 = 'Bra144.ltm'
* LOCATION 54
* Cameroon Batouri
CLFILE54 = 'Cmr7.ltm'
* LOCATION 55
* Cameroon Douala
CLFILE55 = 'Cmr6.ltm'
* LOCATION 56
* Colombia Andagoya
CLFILE56 = 'Col16.ltm'
* LOCATION 57
* Colombia Villavicencio
CLFILE57 = 'Col27.ltm'
* LOCATION 58
* Ghana
Hon
CLFILE58 = 'Gha10.ltm'
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* LOCATION 59
* Ghana
Kumasi
CLFILE59 = 'Gha8.ltm'
* LOCATION 60
* Ghana
Tafo
CLFILE60 = 'Gha99.ltm'
* LOCATION 61
* Cote d'Ivoire
Abidjan
CLFILE61 = 'Civ8.ltm'
* LOCATION 62
* Cote d'Ivoire
Gagnoa
CLFILE62 = 'Civ7.ltm'
* LOCATION 63
* Ivory Coast
Man
CLFILE63 = 'Civ5.ltm'
* LOCATION 64
* Malaysia Kuala Trengganu
CLFILE64 = 'Mys8.ltm'
* LOCATION 65
* Malaysia Penang
CLFILE65 = 'Mys1.ltm'
* LOCATION 66
* Malaysia Sandakan
CLFILE66 = 'Mys37.ltm'
* LOCATION 67
* Malaysia Tawau
CLFILE67 = 'Mys99.ltm'
* LOCATION 68
* Papua New Guinea Madang
CLFILE68 = 'Png3.ltm'
* LOCATION 69
* Papua New Guinea Rabaul
CLFILE69 = 'Png9.ltm'
* LOCATION 70
* < specify location name and period of weather data here >
CLFILE70 = ' '
* LOCATION 71
* < specify location name and period of weather data here >
CLFILE71 = ' '
* LOCATION 72
* < specify location name and period of weather data here >
CLFILE72 = ' '
* LOCATION 73
* < specify location name and period of weather data here >
CLFILE73 = ' '
* LOCATION 74
* < specify location name and period of weather data here >
CLFILE74 = ' '
* LOCATION 75
* < specify location name and period of weather data here >
CLFILE75 = ' '
!======================================================================!
!
!
! PART B. NO changes may be made to this part of the data file.
!
!
!======================================================================!
!---------------------------------!
! Output
!

Appendix III: Listing of input files

III-13

!---------------------------------!
* per yr
PRSEL1='YEAR','ageyr','YRAIN','YRDD','YTRANS','WTOT','WRT','WTOTPP','WLV','WWD','WT
RT','WLRT','WPD','YGPHOT','YGTOT','YYLDPD','YYLDBN','YLVD','YWDD','WPDCUM','WBNCUM'
,'YHI','YHINCR','YMNBH','YMNLAI','YMNIPOD','YHARPD','YRDEFF','YRNEFF','YNLOSS','YPL
OSS','YKLOSS','<TABLE>'
* per 10 days
PRSEL2='year','doy','ageyr','tmav','pcew','lai(1)','WTOT','wtotpp','wrt','wlrt','wt
rt','wlv','wwd','wpd','WPDCUM','WBNCUM','D10GTOT','D10YLDPD','D10YLDBN','D10RAIN','
D10RDD','D10HARPD','<table>'
* per day
PRSEL3='year','doy','ageyr','rdd','rain','tmav','atrans','ptrans','pcew','frabs(1)'
,'lai(1)','WTOT','wtotpp','wrt','wlrt','wtrt','wlv', 'wwd', 'wpd',
'gphot','maint','GTOT','gpd','glv','grt','glrt','gtrt','GWD','GTOT1','GTOT2','FLV',
'FWD','FPD','FTRT','FLRT','dwd','dlrt','dlv','dlv1','dlv2','ltrt','yldpd','YLDBN','
BHYLD','harpods','WPDCUM','WBNCUM','<table>'
* years and days for which output is
IOBSD = 1000, 365
1956, 366, 1957, 365, 1958,
1961, 365, 1962, 365, 1963,
1966, 365, 1967, 365, 1968,
1971, 365, 1972, 366, 1973,
1976, 366, 1977, 365, 1978,
1981, 365, 1982, 365, 1983,
1986, 365, 1987, 365, 1988,
1991, 365, 1992, 366, 1993,
1996, 366, 1997, 365, 1998,
2001, 365, 2002, 365

generated in case of annual output
365,
365,
366,
365,
365,
365,
366,
365,
365,

1959,
1964,
1969,
1974,
1979,
1984,
1989,
1994,
1999,

365,
366,
365,
365,
365,
366,
365,
365,
365,

1960,
1965,
1970,
1975,
1980,
1985,
1990,
1995,
2000,

366,
365,
365,
365,
366,
365,
365,
365,
366,

! List of observation data for which output
! is required. The list should consist of
! pairs of <year>,<day> combinations.
IPFORM = 5

COPINF = 'N'

DELTMP = 'Y'

STTIME = 1.
DELT
= 1.

!
!
!
!
!
!
!
!
!
!
!
!
!
!
!
!

Format of output file:
0 = no output table,
4 = normal table,
5 = tab-delimited (Excel),
6 = TTPLOT format
Switch variable what should be done with
the inputfiles:
'N' = do not copy inputfiles into
outputfile,
'Y' = copy inputfiles into outputfile
Switch variable what should be done with
the temporary and binary output file:
'N' = do not delete,
'Y' = delete
Start day of simulation
Time step of integration

* Radiation parameter
FRPAR = 0.5
IFLAG

= 1101

! Indicates where weather error and warnings
! go (1101 means errors and warnings to log
! file, errors to screen, see FSE manual)

PLTMOD = 'CACAO'
* PLTMOD = 'NO CROP'
ETMOD = 'PENMAN'
* ETMOD = 'MAKKINK'
* ETMOD = 'PRIESTLEY/TAYLOR'

